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About This User’s Manual

This manual provides detailed instructions on how to set up, use, and maintain Atrust mt180W mobile thin clients.

Manual Structure and Subjects

Chapter Subject

1

Provides an overview of Atrust mt180W mobile thin clients.

2 Provides detailed instructions on how to set up Atrust mt180W mobile thin clients.
3 Provides the basics of how to use Atrust mt180W mobile thin clients.
4 Provides instructions on how to configure client settings and customize Atrust mt180W
mobile thin clients with the Atrust Client Setup console.
Appendices Provides supplementary instructions on the maintenance and upgrade of
PP Atrust mt180W mobile thin clients.
Specifications Provides detailed information on key components of Atrust mt180W mobile thin clients.

Notes, Tips, and Warnings

Throughout this manual, the notes, tips, and warnings in the following formats are used to provide important
information, useful advice, and prevent injuries to you, damage to your devices, or loss of data on your system.

NOTE

(alll |

« A note provides important information for a specific situation.

TIP

74

- Atip gives a piece of useful advice to perform a task more efficiently.

@ WARNING

« A warning provides crucial information that must be followed to prevent injuries to
you, damage to your devices, or loss of data on your system.



Style Conventions

The following styles are used throughout this manual while referring to operational items on input devices,
hardware panels, or application interfaces.

Item

keys on the keyboard

application windows or
entry lists

buttons or tabs on a
window, toolbars, taskbar,
or menu

options on a window,
screen, list, or menu

selecting a series of options

Style
bold

first letter

capitalized

bold

bold

bold

Example

ctrl + F2, Ctrl + Alt + F9, Alt + Tab

ICA Connection list, RDP Connection list, View Connection list

OK, Next, Save, Applications tab
Start the following program on connection, Remote Desktop
Services, Better Appearance (32-bit), Web Logon

Applications > Citrix ICA, Applications > Remote Desktop,
Applications > VMware View, System > UWF



Safety and Regulatory Information

Regulatory Statement

Federal Communications Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one of the following measures:

« Reorient or relocate the receiving antenna.
« Increase the separation between the equipment and receiver.
« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate this equipment. This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20 cm between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.



Regulatory Information

WEEE (Waste Electrical and Electronic Equipment) Directive
In the European Union, this symbol indicates that this product should not be disposed of with
household waste. It should be deposited at an appropriate facility to enable recovery and recycling. For
mmm  proper disposal, please contact your local recycling or hazardous waste center.

Safety Information

@ WARNING

+ Use only power supplies listed in the user instructions.

@ WARNING

- Danger of explosion if battery is incorrectly replaced. Replace only with the same or
equivalent type recommended by the manufacturer.

@ WARNING

- For safety, do not make mechanical or electrical modifications to the equipment.

- Do not remove equipment covers and access any of the components inside the
equipment. Any access inside the equipment without an authorized or certified
technician may cause serious injuries and damage. For any problem, contact your
dealer for assistance.

+ You should only make repairs as authorized by the product documentation.
Repairs, replacement, expansion, and upgrades not performed by a certified service
technician may cause injuries to you, damage your system, and void your warranty.
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Overview

This chapter provides an overview of Atrust mt180W.
1.1 Introduction
Desktop virtualization and simple endpoint devices

1.2 Features
Key features of Atrust mt180W

1.3 Package Contents
Check your package contents

1.4 Exterior Views
Exterior design of Atrust mt180W

1.5 Exterior Components
Exterior components of Atrust mt180W






Overview
Introduction

1.1 Introduction

Desktop virtualization provides a new perspective to reconsider the design and implementation of an IT
infrastructure. In a desktop virtualization infrastructure, a station is no longer a cumbersome desktop, but simply
an endpoint device for users to access delivery services from the server(s).

With the introduction of the desktop virtualization technologies, you can considerably benefit from:

« On-demand applications/desktops

« Centralized management of work environments

« Drastically reduced endpoint software/hardware issues

«  Simplified system maintenance and improved system security

+  More scalability with low-cost endpoint devices

1.2 Features

The key features of Atrust mt180W mobile thin clients are:

«  Built-in Wireless 802.11 b/g/n and Ethernet network interface
«  Support for a wide range of desktop virtualization solutions from industry-leading companies:
o Microsoft® Remote Desktop
o Citrix® XenApp™, XenDesktop®, and VDI-in-a-Box™
o VMware® View™ and Horizon View™
+  Support for high-definition technologies
o Microsoft® RemoteFX®
o Citrix® HDX™
o VMware® View™ PColP®
- Simple click-access to various applications/desktops

«  Built-in Atrust Client Setup as the local client management console

1.3 Package Contents

Please check your package contents. Ensure that all of the items are present in your package. If any items are
missing or damaged, please contact your dealer immediately.

Atrust mti80W AC adapter Battery

Quick Start Guide

NOTE: Your package may not contain a hard copy of the Quick Start Guide.
In this case, a soft copy in PDF format will be provided.

3



4| Overview
Exterior Views

1.4 Exterior Views

Front View

Left View Right View

Bottom View and Battery




Overview |5
Exterior Components

1.5 Exterior Components

Display and Base Components

o ¢ x b & &

No. Sign Component Description
1 LCD display Built-in display for visual output.
2 Microphone Built-in microphone for audio input.
3 (D Power button : E(r)isgs sgeggvtvc?;'3:]c£:hgewn;::ri'li;;ﬂtlaed:ﬁg%ile thin client.
4 Speaker Built-in speakers for audio output.
5 Keyboard Built-in keyboard for control and input.

6 Touchpad Built-in pointing device for control and input.
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Fn Key Combinations

With the combination of Fn B plus another specific key (with one printed blue symbol on it), you can quickly
adjust hardware settings to suit your needs.

N
Esc Fl F2 F3 F4 F5 F6 F7 F8 Fo F10 F11 F12 PriScr | | Pause Ins Del
=y 2 P1 = ) > 2 ) | SysRq | | Breck | |NumLk | | Scrlk
~ | @ # $ % A & 7 * 8 (9 )/ - + Backspace He
lome
N 1 2 3 4 5 €]|6 7 8 9 0 - =
- Q w E R T Y U 4|1 5O 6||P | |{ } |
% Tab PgUp
[ 1 \
Caps Lock <! Enter PgDn
— — H '
0 < > ? 0+
A shift z X c v B N M A shifr 4 End
/ W o
|
crl Fn = Alt AltGr =l Crl -« v -»>
\ 1) Gv )
J

NOTE

« To use an Fn key combination, press and hold Fn, and then press another key.

0
)
3
=
=}
Q
=
o
E

Description

Combination

Description

Use to enable / disable Num Lock mode.

keyboard to exit.

| +]|™ ) Use to switch the use of displays. o[+ Num Lock Mode: allows to enter digits
— and symbols using Fn key combinations.
7 |+|™ | Use to enable / disable the touchpad. fno |+ This is not supported by your model.
o o[ Use to define the custom action. S Use to increase the brightness of
PIJ" This is not supported by your model. <+ | the LCD display.
R Use to enable / disable the ECO mode. oLl Use to decrease the brightness of
=) ECO Mode: brightness 0 to save power & the LCD display.
- Use to decrease the volume of
. F6 . -
fno |+ »| Webcam is not supported by your model. fno |+ b the built-in speakers.
o |+ Use to enable / disable the Flight mode. I Use to_in<_:rease the volume of
) Flight Mode: disabled wireless module ©) | the built-in speakers.
Use to enter the System Sleep mode. —
oo |+ Press the Power button or any key on the oo T| e Use to mute / unmute the sound.

Combination

Description

‘ Mol s 1] [k 2] [L 3] |u 4
Fn + / / / /
I 51 0ol a7 [+ s o Use to type in the desired digit or symbol.
|+ / / 5 / 8 / 9
NOTE: You must enable the Num Lock mode first.
) P = : 7+ >
|+ / / / /
EIEF A




Left and Right Side Components
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No. Sign Component Description

7 === DC IN Connects to an AC adapter.

8 O VGA port Connects to an external display.

9 E LAN port Connects to a network.

10 0%» USB port Connects to a USB device.

11 Q Headphone port Connects to a set of headphones or a speaker system.

12 @ Microphone port Connects to a microphone.

13 O-%P USB port Connects to a USB device.

14 (Sc?;;':n(;?)rd slot Reads/Writes data from a smart card.

15 Kensington security slot Connects a Kensington cable to secure the mobile thin client.




il

Overview
Exterior Components

Front Side Components

No. Sign Component Description

16 8 Storage LED Glows blue when eMMC (flash memory) is being accessed.
17 9 Bluetooth LED Glows blue when Bluetooth is enabled (not supported).

18 x Wi-Fi LED Glows blue when Wi-Fi is enabled.

i

20 Caps Lock LED Glows blue when Caps Lock is enabled.

21 Num Lock LED Glows blue when Num Lock is enabled.

Bottom Components

I |
Ol | ) ||
® = 2
o
[ ] 0

No. Sign Component Description
22 Lithium-ion battery Supplies the moblle thlq client with the power when an external

power source is not available.

Unlocks the battery by sliding and holding left.

= [+ .

23 RELEASE Left battery latch NOTE: To remove the battery, use the right battery latch to
unlock the battery, and then slide left and hold this latch
to remove the battery.

Locks / Unlocks the battery by sliding left / right.
24 UNLOCK Right battery latch NOTE: To remove the battery, use this latch to unlock the

battery, and then slide left and hold the left battery latch
to remove the battery.
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1.6 Before Getting Started
About UWF (Unified Write Filter)

Before getting started on client configuration through the Atrust Client Setup console or through the Windows
Embedded Standard operating system, please note that in a session any changes to the system will not be kept by
default after the system restart. This is due to a special feature called UWF (Unified Write Filter) in your Windows
Embedded-based system.

By default, your mt180W is UWF-enabled. Unified Write Filter (UWF) is a sector-based write filter intercepting all
write attempts to a protected volume and redirecting those write attempts to a virtual overlay. With UWF, all system
changes will only affect the session where the changes are made. After restart, all changes will be discarded.

You can change the default via the Atrust Client Setup console. It's strongly recommended that you read the related
section in this user’s manual first before making any changes to your system.

@ WARNING

« Please read the following section FIRST before making any changes to your system:
“4.2.9 Configuring UWF (Unified Write Filter)” on page 49.

=)) NOTE

al

+ As a thin client device, your mt180W is mainly for access to remote or virtual
desktops on servers. With the limited and protected (UWF-enabled) hard disk space,
it's not recommended to save data on your mt180W. Instead, you can use storage
spaces over remote / virtual desktops, removable storage devices, or networks.

« In case that you need to copy a file to the protected volume, ensure that its size is
smaller than the free memory (overlay) space. Otherwise, your system may have
unexpected results or become unresponsive.

About Default User Accounts

There are two default user accounts for your Windows Embedded-based system: one is the standard, the other
administrative. The default credentials are shown as follows:

Type Account Name Password
Administrator Administrator Atrustadmin
Standard user User Atrustuser
=) NOTE
7

« The passwords are case sensitive.

About the Behavior of System Startup

Every time when the system is started up, it will automatically log in to the Windows Embedded operating system
using the default standard user account as indicated in the preceding table about default user accounts.

9
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1.7 Service Access with your mt180W

With Atrust mt180W, you can simply access desktop virtualization solutions from Microsoft, Citrix, and VMware, by
mouse-clicking. Two types of access shortcuts are available: standard and customized. The former is available on
the desktop of Windows Embedded by default; the latter can be created and customized through the Atrust Client
Setup console.

Standard Desktop Shortcuts

You can find the instructions on how to use standard desktop shortcuts to access on-demand applications or
desktops in chapter 3 “Getting Started” on page 15 or in the Quick Start Guide for mt180W.

Customized Desktop Shortcuts

You can find the instructions on how to create and customize access shortcuts in chapter 4 “Configuring Client
Settings” on page 29.



Setting Up Your mt180W

This chapter provides detailed instructions on how to set up
your mt180W mobile thin client.

2.1 About the AC Adapter
Information on the use of the AC adapter 13

2.2 Charging Your Lithium-ion Battery

How to charge your lithium-ion battery 13
(Recommended for first time use)

2.3 Setting Up Your mt180W
How to set up your mt180W 14






Setting Up Your mt180W
About the AC Adapter

2.1 About the AC Adapter

To use the supplied AC adapter, please do the following:

1. Unpack your mt180W package, and then take out the AC adapter and its detached power cord.
2. Attach the power cord to the AC adapter to assemble your AC adapter.

2.2 Charging Your Lithium-ion Battery

NOTE

v/
« For the first time use, it's recommended to charge your Lithium-ion battery first.

To charge your lithium-ion battery, please do the following:

1. Slide the battery into the battery compartment until it clicks into place, and then Slide left the right battery
latch to lock the battery securely.

8
(o
8

o

®
)

Slide left completely to
ensure the battery is
securely locked.

= - ‘
U
MR

2. Attach the DC plug of the AC adapter to your mt180W, and then connect the AC plug of the adapter
to a power outlet.

3. The Battery LED glows orange while the battery is being charged.
4. On completion, the Battery LED glows blue.

13
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2.3 Setting Up Your mt180W

To set up your mt180W, please do the following:
1. Use the AC adapter or the Lithium-ion battery as the power source:

« To use the AC adapter, attach its DC plug to your mt180W, and then connect its AC plug to a
power outlet.

« To use the Lithium-ion battery, slide it into the battery compartment until it clicks into place, and then
slide left the right battery latch to lock the battery securely.

®

Slide left completely to
ensure the battery is
securely locked.

2. Connect the LAN port to your local network with an Ethernet cable or set up a wireless connection later.



Getting Started

This chapter provides the basics of how to use your mt180W.

3.1 Standard Shortcuts

Default shortcuts on the local (Windows Embedded
Standard) desktop

3.2 Accessing Citrix Services
How to access Citrix services

3.3 Accessing Microsoft Remote Desktop Services

How to access Microsoft Remote Desktop services

3.4 Accessing VMware View and Horizon View Services
How to access VMware View and Horizon View services

17

18

24

26
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3.1 Standard Shortcuts

You can access virtual desktop or application services simply through standard shortcuts available on the desktop.

No. Shortcuts Description See
Double click to access Citrix services.

NOTE: If the secure network connection is not implemented in your
Citrix environment, you might not be able to access Citrix

1 Chmr Resenves services through Citrix Receiver of this new version. Alternatively, =
Citrix allows service access simply through a Web browser. Try to
use the built-in Internet Explorer if you have problems with Citrix
Receiver (refer to instructions in this chapter).
Remote Desktop Connection Double click to access Microsoft Remote Desktop services. 3.3

VMware Horizon View Client Double click to access VMware View and VMware Horizon View services. 3.4



18| Getting Started

Accessing Citrix Services

3.2 Accessing Citrix Services

Accessing Citrix Service with Internet Explorer
To quickly access Citrix services with the Internet Explorer, please do the following:

1. Open the Internet Explorer by clicking its icon on the Start screen or the desktop taskbar.

2. Enter the IP address / URL / FQDN of the server through which Citrix services are accessible.

@ NOTE

« For XenDesktop 7.0 or the later, consult your IT administrator for the appropriate
IP address / URL / FQDN.

3. Follow the on-line instructions to provide the required data and access Citrix services.

Logon Screen Example
XenDesktop 5.6 Platinum

ginzs £ + B O | © CiricxenDesktop -Logon  x [

Citrix XenDesktop

Log on

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.




mt180W Local Desktop

el m [=]

Looki:

5 Dommers
Name +

Virtual Desktop Example
Windows 7 Ultimate
(launched in mt180W)

Welcome to the virtual workstyle

Your desktop, apps and documents at your fingertips
ur vinual deskiop, and he freedom 10 4o Whatever, henever
4 by Gilix XenDesKiop.

Virtual Application Examples

PowerPoint Viewer, Adobe Reader, and Skype

Bl Edt_View o

(launched in mt180W)

= e OB EG B ® 000 @ e —

|| Dte mocified [+| Type 1=l
n

N2> B=dei\d

‘Adobe ExportPDF
Comvert POFfle to Word or Excel
oniine.

SelectPOF File:

Adobe Online Services
JE——

T2 ceneror
ccognize e inEngich(US)

b s
P

(B cutecmens s

| i)

Fiegame:

Fies o pe:

|

[PonerPort Presertaiors

=

Getting Started

Accessing Citrix Services
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Accessing Citrix Services

Accessing Citrix Service through the Citrix Receiver Shortcut

To access Citrix services through the Citrix Receiver shortcut, please do the following:

1. Import the required safety certificate for available Citrix services with an administrator account. Consult your
IT administrator for necessary assistance.

a. On the desktop, move the mouse to the bottom-left corner, and then right click on the appeared

. A popup menu appears as shown below.

“rams and Features
Power Options
Event Viewer
System
Device Manager
Disk Management
Computer Management
Command Prompt
Command Prompt (Admin)
Task Manager
Control Panel

File Explorer
Search

Desktop

b. Click to select Run on that popup menu.

¢. Enter mmc on the opened window, and then

@ Type the name of a program, folder, document, or Internet
press Enter. {

resource, and Windows will open it for you.

Open: | mmc v
d. Onthe Console WindOW, click the File menu ) This task will be created with administrative privileges.
to select Add/Remove Snap-in.

|| Cancel || Browse... |
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Accessing Citrix Services

File | Action View Favorites Window Help
- New Ctrl+N
& Open... a0 [ o =
Save Ctrl+5
Save As... There are no items to show in this view. _
More Actions.
| Add/Remove Snap-in.. Ctrle M
Options...
1 CWindows\..\eventwn.msc File | Action Faverites  Window Help
Gl ° New
.
© Open
. peEn.
°
° Save
Save As...
Add/Remove Snap-in...
Options...

1 ChAWindowsh.. \eventvwr.msc

Exit

Enables you to add snap-ins o or remove them from the snap-in console.

e. On the opened window, click Certificates > Add > Computer account > Local computer > OK to add
the Certificates snap-in.

Available snap-ns:

Snap-n

=" Activex Control
ﬂAuﬂmrizﬁhun Manager
= certificates
Component Services
@Compuber Managem...
ﬂnevice Manager
ﬁDisk Management

E Embedded Lockdow...
g Event Viewer
[IFoider

Group Policy Object ...
&, 1P Security Monitor
&, IP Security Palicy M...

Vendor

Microsoft Cor...
Microsoft Cor.
Microsoft Cor,
Microsoft Car,
Microsoft Cor.
Microsoft Cor...
Microsoftand...
Copyright {c) ...
Microsoft Cor...
Microsoft Cor.
Microsoft Cor.
Microsoft Cor...
Microsoft Cor...

Description:

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled,

Selected snap-ns:

[ Console Root

Ediit Extensions.

Remove

Move Up

Move Down

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

21
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Accessing Citrix Services

f.  On the Console window, click to expand the group tree of Certificates, right-click on Trusted Root
Certification Authorities, and then select All Tasks > Import on the popup menu.

T Object Type

e 2B o BE

[ Console Root
4 [ Certificates (Local Computer)
v [7] Personal

[T Certificates

1 [ Enterprise Trust

b [ Intermediate Certification Authr

b [] Trusted Publishers

b ] Untrusted Certificates 1

» ] Third-Party Root Certificati orrties
b [7] Trusted People

1 (] Client Authentication lss:

b [ Smart Card Trusted Roo'

b [ Trusted Devices

b [ Windows Live ID Toker

n Authon

1 [] Trusted Root Certification Authoriti |

Find Certificates...

N

More Adtions »

All Tasks

View
Mew Window from Here

Mew Taskpad View...

Refresh
Export List...

Help

Find Certificates...

Import...

Add a certificate to a store

g. Follow the Certificate Import Wizard to import your certificate, and then close the Console window

when it's done.

Store Location
() Current User

(®) Local Machine

To continue, dick Next.

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
conmections. A certificate store is the system area where certificates are kept.

Goce
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Accessing Citrix Services

2. Double click Citrix Receiver EII|1 Z4) on the desktop.

3. A window appears prompting for the work email or server address. Consult your IT administrator for proper
information to provide here, enter the required data, and then click Next to continue.

Citrix Receiver”

Enter your work email or server address:

If you do not need to add an account, click Cancel. If you need
to add an account later, start Citrix Receiver and choose
Accounts,

4. Sign in with credentials for your Citrix services, and then in the opened window, click Yes to optimize your
Citrix access. When it's completed, a success message appears. Click Finish to continue.

Citrix Receiver™
Do you want to allow Citrix Receiver to makq =
to your computer to optimize access to "Lyn

» View details of this download

Citrix Receiver”

J Your account has been added successfully.

23
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Accessing Microsoft Remote Desktop Services

5. A window appears allowing you to add favorite apps (virtual desktops and applications) for the provided
credentials. Click to select the desired application(s). The selected application(s) will appear on that window.

Citrix Receiver

CitrixReceiver

Al Applications.

6. Now you can click to launch the desired application. The virtual desktop or application will be displayed
on the screen.

3.3 Accessing Microsoft Remote Desktop Services

To quickly access Remote Desktop services, please do the following:

1. Double click Remote Desktop Connection %:\ on the desktop.

2. Enter the name or IP address of the remote computer on the opened window, and then click Connect.

LT Remote Desktop Connection - ©

| Remote Desktop
) Connection

Computer: | Bxample: computer fabrikam com W

Username:  MNone specified

The computer name field is blank. Enter a full remote computer
name.

> Show Options Help
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Accessing Microsoft Remote Desktop Services

3. Enter your credentials, and then click OK.

Enter your credentials

These credentials will be used to cennect to 192.168.10.100,

“Jser name
I I ’ Password

Domain:

[ Remember my credentials

4. A window may appear with a certificate message about the remote computer. Consult your IT administrator
for details and ensure the connection is secure first. To bypass, click Yes to continue.

The remote computer could not be authenticated due to problems with its
securty certificate. it may be unsafe to proceed.

Certfficate name

@ Mame in the certificate from the remote computer:
WMS2011P

Certficate emors

The following emors were encountered while validating the remote
computer's certificate:

ﬁk The certificate is not from a trusted cerifving authority.

Do you wart to connect despite these cenfficate emors?
[] Don't ask me again for connections to this computer

View cerificate...

5. The remote desktop will be displayed on the screen (in full-screen by default).

25
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Accessing VMware View and Horizon View Services

3.4 Accessing VMware View and Horizon View Services

To quickly access VMware View or Horizon View services, please do the following:

1. Double click VMware Horizon View Client 'z~ " on the desktop.
2. A window appears allowing you to add the name or IP address of the View Connection Server.

3. Double-click Add Server icon or click New Server in the top-left corner.

+ Mew Server | || + newsener

Add Server

Add Server

4. A window appears prompting for the name or IP address of the View Connection Server. Enter the required
information, and then click Connect.

=

vmware Hc

Enter the name of the Connection Server,

Connect

5. A window may appear with a certificate message about the remote server. Consult your IT administrator for
details and ensure the connection is secure first. To bypass, click Continue.

have contacted. Your credentials will not be secure. Contact your

i WMware Horizon Client cannot verify the identity of the server you
administrator to ask if this server can be trusted.

Show Certificate Continue | | Cancel
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6. A window may appear with a Welcome message. Click OK to continue.

7. Provide your user name and password on the opened window, and then click Login.

=
E

vmware Horizon

Server:

User name:

Password:

Domain:

ﬁ R /WS, VHY . poc
|
|

VHY

8. A window appears with available desktops or applications for your credentials. Double-click to select the

desired desktop or application.

&Y @B wcs.vHv.poc

Mozilla Firefox

Windows Media
Player

(5]

WS08R2

o)

Motepad

Adobe Reader XI Calculator LINE

P B %

Snipping Tool

9. The desktop or application will be displayed on the screen.

27
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Configuring Client Settings

This chapter provides instructions on how to configure advanced
settings and customize your mt180W with Atrust Client Setup.

4.1 Atrust Client Setup
Interface overview
Available settings at a glance

4.2 Configuring System Settings

System tab overview
Available settings at a glance

4.3 Configuring External Device Settings
Devices tab overview
Available settings at a glance

4.4 Configuring User Interface Settings
User Interface tab overview
Available settings at a glance

4.5 Configuring Service Access Settings

Applications tab overview
Available settings at a glance
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4.1 Atrust Client Setup

4.1.1 Interface Overview

To access Atrust Client Setup on your mt180W thin client, please do the following:

1. Login to your mt180W with an administrator account (see page 4 for the default).
2. Click Atrust Client Setup on the Start screen.
3. The Atrust Client Setup window appears.

Interface Overview

O © 0 0

ecece
ecece
ecece
ecece

Atrust Applications | User Interface | Devices | System

» Remote Desktop

@ eeee e e e®e i Citrix ICA | Remote Desktop Available Sessions: 0 LXY ]
i Configure RDP (Remote Desktop Protocol) connection settings

b VMware View
+ Web Browser W Citrix ICA Available Sessions: 0
Configure Citrix ICA connection settings

B VMware View Available Sessions: 0
I’ Configure VMware View connection settings

& Web Browser Available Sessions: 0
9 Configure local browser settings

Interface Elements

No. Name Description
1 System tab Click to configure settings for the operation and maintenance of the client.
2 Devices tab Click to configure settings for external devices of the client.
3 User Interface tab Click to configure the user interface of the client.
4 Applications tab Click to configure settings for service access through the client.

Click to select a setting item under a selected tab or to select a setting entry under

> Navigation area a selected setting item.

6 Configuration area Configures setting values when a setting item or entry is selected.

31
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4.1.2 Client Settings at a Glance

The following table provides a brief description of each setting item under four main setting categories.
Tab Setting Item Section Page

e Configuring passwords
e Configuring remote assistance settings
e Updating firmware . .
System ) 4.2 Configuring System Settings 33
e Taking snapshots for mass deployment
e Enabling/Disabling the Appliance mode

e Configuring UWF (Unified Write Filter) settings

e Configuring settings for USB storage devices

Devices T . ] ; 4.3 Configuring External Device Settings 51
e Configuring settings for audio devices
User Interface e Configuring the display of service access shortcuts 4.4 Configuring User Interface Settings 54
e Configuring Microsoft RDP connection settings
o e Configuring Citrix ICA connection settings . . . .
Applications 4.5 Configuring Service Access Settings 56

e Configuring VMware View connection settings
e Configuring Web browser session settings

NOTE

« The table above is only applicable to Atrust mt180W thin clients running Windows
Embedded 8 Standard. The available setting categories and items of the Atrust
Client Setup console for other Windows Embedded-based, Linux-based, and
ARM Linux-based thin clients might be different.

Lalll |
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4.2 Configuring System Settings

4.2.1 System Tab Overview

System tab enables you to configure settings for the operation and maintenance of clients. To access available
settings of System tab, click the tab on Atrust Client Setup.

.
System Tab Overview
Atrust Applications | User Interface | Devices | System
aoooooooco o+ Password
+ Firmware Update Password . . . eoe eeccccce 9
Configure administration privileges and remote assistance settings
* Snapshot
» Appliance Mode t‘) Firmware Update
» UWE = Update firmware for this client.

B snapshot
s B3ck up the current system state.

Appliance Mode
Configure Appliance mode

UWF
Configure Unified Write Filter to protect your disk drives from unwanted changes

D

Interface Elements

No. Name Description

1 Navigation area Click to select a setting item under System tab.

2 Configuration area Configures setting values when a setting item is selected.
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4.2.2 Available Settings at a Glance

Tab Setting

Password

Firmware
Update

Snapshot
System

Appliance
Mode

UWF

NOTE

(alll |

+ Atrust Device Manager is a remote and mass client management console, helping
you remotely mange a large number of endpoint devices in a desktop virtualization
infrastructure. For more information about Atrust Device Manager, please refer to

Icon

F3

Description

Click to configure the access privileges of Atrust
Client Setup for client users.

Click to configure settings for remote assistance.

Click to update firmware locally with the help of
a remote management computer. This feature is
only applicable when the client is managed by
the Atrust Device Manager console.

Click to take a snapshot (system image) of the
client for mass deployment.

Click to enable/disable the Appliance mode to
allow/disallow the automatic RDP / ICA / View
sessions. In Appliance mode, the client starts up
with the desired RDP / ICA / View session and
shuts down when the user logs out.

Click to configure UWF (Unified Write Filter)
settings. Enabling UWF option will redirect all
writes targeted for disk volumes to a RAM cache.
All system changes will only affect the session
where the changes are made.

the User’s Manual for Atrust Device Manager.

Section

4.2.3

4.2.4

4.2.5

4.2.6

4.2.7

4.2.8

4.2.9

Page

35

37

38

41

42

45

49
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4.2.3 Configuring the Access Privileges and Password of Atrust Client Setup

You can configure the access privileges of Atrust Client Setup for client users by the Password setting.

Setting Access Privileges and Password Only for Administrators
To set access privileges and password only for administrators, please do the following:

%J’ NOTE

+ System administrators (and only administrators) are allowed to access Atrust Client
Setup by default. If you don't enable user authentication for administrators and
don't set a password here, the system administrator privileges are sufficient to
access Atrust Client Setup. If authentication is enabled and the password is set,
administrators will need that password to enter Atrust Client Setup.

1. On Atrust Client Setup, click System > Password.

Atrust Applications | User Interface | Devices | System
~ Password
» Firmware Update — Administrator

» UWF -
[} [ Active Admin

Authorization

r— Shadow

& Oenable shadow

| save ‘1 Cancel

2. Under the Administrator section, click to check Active Admin Authorization.

3. The access privileges for administrators are granted and a window appears for you to set the password.

Active Admin Authorization

Password: |
Confirm Password: #
! Save H Cancel

4. Type in the desired password, and then click Save to apply.

5. Click Save to store all the changes.
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Setting Access Privileges and Password Also for Standard Users
To set access privileges and password also for standard users, please do the following:

1. On Atrust Client Setup, click System > Password.

2. Under the User section, click to check Use Password.

Atrust Applications User Interface Devices System
~ Password
b Firmware Update — Administrator

3 -
. E Ml active Admin

Authorization

— User

& Ouse password

r— Shadow

& Uenable shadow

i Save 7H Cancel |

%J‘ NOTE

+ The User section appears only when Active Admin Authorization is checked.

3. The access privileges for standard users are granted and a window appears for you to set the password.
4. Type in the desired password, and then click Save to apply.

5. Click Save to store all the changes.

3’/ NOTE

- For standard users of your mt180W, two set of credentials are required to access
Atrust Client Setup: one set of credentials is administrator credentials for Windows
Embedded 8 Standard; the other is standard user credentials for Atrust Client Setup.
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4.2.4 Configuring Shadow Settings for Remote Assistance

The Shadow feature allows an administrator to remotely assist client users in resolving problems or configuring local

settings. When this feature is enabled, an administrator can monitor and control a client from a remote computer
just like a local user.

%J‘ NOTE

+ To use the Shadow feature on a remote computer, you need to install the Atrust
Device Manager and also Java software on the remote computer, and add your
client into a managed group under Atrust Device Manager. For detailed instructions,
please refer to the User’s Manual for Atrust Device Manager.

To enable the Shadow feature and set the password for remote assistance, please do the following:

1. On Atrust Client Setup, click System > Password.

Atrust Applications User Interface Devices System
~ Password
» Firmware Update — Administrator

* UWF -
& Oactive Admin

Authorization

r— Shadow

& Oenable shadow

| Save H Cancel

2. Under the Shadow section, click Enable Shadow.

3. The Shadow feature is enabled and a window appears for you to set the password for remote assistance.

Active Shadow Authorization
Password: "l

Confirm Password: “l

save || Cancel




38| Configuring Client Settings
Configuring System Settings

NOTE

(alll |

- On aremote computer, an administrator will need this password to use the Shadow
feature (remote assistance) available in the Atrust Device Manager console. For
more information, please refer to the User’s Manual for Atrust Device Manager.

4. Type in the desired password, and then click Save to apply.

5. Click Save to store all the changes.

NOTE

W)

« When the Shadow feature is enabled, on mt180W, the icon will appear in the
Notification area of the Task bar. If this feature is currently being performed from a
remote computer, the icon will change its color to yellow E

4.2,5 Updating Firmware from the Management Computer

Update Firmware allows users to update client firmware from the remote management computer to get the
client device up-to-date.

NOTE

i)

- Ensure that your client has been added into a managed group under Atrust Device
Manager installed on a remote computer, and that you have imported client
firmware files into Atrust Device Manager. These are prerequisites of this feature.

« For more information on firmware update and Atrust Device Manager, please refer
to the User’s Manual for Atrust Device Manager.

To update client firmware from the remote management computer, please do the following:

1. On Atrust Client Setup, click System > Firmware Update.
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Atrust Applications | User Interface | Devices | System
Navigator
sener

» Password

~ Firmware Update Firmware Update

»
Tagrieh Current Version: WEBS 1.11-PREA (mt180W;mt168W)

Firmware Type: {ALL

+ Appliance Mode
» UWF

e

Check Firmware ‘

* WARNING! This will remove all data you have placed on this machine.

* This setting will take effect after reboot.

Cancel

2. Under the Firmware Update section, click the Firmware Type drop-down menu to select Firmware. The
system will then automatically download the Firmware list from the remote computer.

@ NOTE

+ You can also update the firmware of a client with a snapshot (the system image of a
client) which is coming from another client of the same model and is with a newer

firmware version. For detailed information, please refer to sections about
the snapshot.

3. On completion, a window appears notifying you that the Firmware list has been loaded.
Click OK to continue.

@'/ NOTE

« The available firmware versions depend on how many versions have been imported
into the remote Atrust Device Manager.

4. Click drop-down menus to select the desired firmware version and other options.
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Atrust

» Password

~ Firmware Update
» Snapshot

+ Appliance Mode

» UWF

Applications | User Interface | Devices | System

General

[~ Firmware Update

Current Version: WESS 1.11-PREA (mt180W;mt168W)

Firmware Type: [Firmware e
Firmware Version: WESS 1.11-PREA ._
Language: [Duteh Me
Reboot immediately: [no e
Keep ACS configuration: \YES E‘h

Check Firmware

* WARNING! This will remove all data you have placed on this machine.

* This setting will take effect after reboot.

Update firmware Cancel

Firmware Update Options

Item

Description

Firemware Type

Click to select the desired firmware type.

Type Description

ALL All firmware types, Firmware and Snapshot.

Firmware The system image of a client.

Snapshot The system image of a client coming from another client of the same model.

Firmware Version

Click to select the desired firmware version from the Firmware list.

Language

Click to select the interface language of the system, including the Atrust Client
Setup console.

NOTE: Available languages may vary with the firmware version.

Reboot immediately

Click to choose whether to restart the system immediately for firmware update
or manually restart the system later.

Keep ACS configuration

Click to choose whether to keep client settings under Atrust Client Setup.

NOTE: If Yes is selected, all client settings under Atrust Client Setup will remain
unchanged after firmware update.
If No is selected, all settings will be restored to the factory default.

NOTE: If the client is managed by Atrust Device Manager and here No is
selected, Atrust Device Manager will fail to manage the client after
firmware update. For more information on Atrust Device Manager, please
refer to the User’s Manual for Atrust Device Manager.

5. Click Update firmware to confirm your selections. The system will start updating its firmware after restart.




Configuring Client Settings |41
Configuring System Settings

4.2.6 Taking Snapshots for Mass Deployment

A snapshot is the system image of a client, allowing you to use that image for mass deployment. This system image
can be stored on a remote management computer or a locally attached USB flash drive.

%J’ NOTE

- To store the system image on a remote computer, ensure that Atrust Device
Manager has been installed on that computer, and that the client has been added
into a managed group under Atrust Device Manager.

« When taking a snapshot, all system specific information, including the Computer
Security Identifier (SID) and computer name, will be reset or removed from the
system image by performing the System Preparation (Sysprep) tool automatically.

% NOTE

- Taking a snapshot will reset the startup behavior to the default (auto-login with the
default standard user account). For details, please refer to section “1.6 Before Getting
Started” on page 9.

To take a snapshot from a client, please do the following:

1. On Atrust Client Setup, click System > Snapshot.

Atrust Applications User Interface Devices System
Navigat
senera
+ Password
» Firmware Update Snapshot
v Si hot
napsho! Snapshot location: |Network E‘h

¥ UWF
Snapshot description: "l ‘L

* CAUTION! The system will reboot immediately for taking snapshot.

Apply Cancel

2. Under the Snapshot section, click the drop-down menu to select where to store the snapshot. Two options
are available: Network and USB.

- To store the snapshot file set on the remote computer, please select Network.
«+ To store the snapshot file set on the locally attached USB flash drive, please select USB.
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3. Type in the desired description for the snapshot, and then click Apply.
4. A message appears prompting for confirmation. Click OK to confirm.

5. The system will restart to complete the process automatically.

%J‘ NOTE

- Please wait for the process to complete automatically. Taking a snapshot needs
several minutes and requires system reboot more than one time. In addition,

the Sysprep process will not be shown on the desktop but only be performed
in the background.

4.2.7 Deploying a System Image with a Created Snapshot

Your snapshots may be stored on a remote computer over the network or on a USB flash drive. Depending on where
your snapshot is located, you can deploy a system image either through a network or a USB flash drive.

%J‘ NOTE

- For detailed information on how to take a snapshot, please refer to section “4.2.6
Taking Snapshots for Mass Deployment” on page 41.

With a Snapshot on a Remote Computer

To deploy a system image on your mt180W with a snapshot on a remote computer, please do the following:

1. On Atrust Client Setup, click System > Firmware Update.

Atrust Applications | User Interface | Devices | System
Navigat
—
» Password
~ Firmware Update Firmware Update
b S hot
napshol Current Version: WESS 1.05-INTL (£180W;t220W;mt180W; 3 180W;t68W)
+ Appliance Mode
Firmware Type: [ALL
» UWF

Me

Check Firmware
* WARNING? This will remove all data you have placed on this machine.

* This setting will take effect after reboot.

| cancal |
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2. Under the Firmware Update section, click the Firmware Type drop-down menu to select Snapshot. The
system will automatically download the Snapshot list from the remote computer.

3. Upon completion, a message appears notifying you that the Snapshot list has been loaded.

%J’ NOTE

- Client snapshots stored on the remote computer are managed by Atrust Device
Manager. For more information on how to manage client snapshots with Atrust
Device Manager, please refer to the User’s Manual for Atrust Device Manager.

4. Click OK to continue.

5. Click drop-down menus to select the desired snapshot and other options.

Atrust Applications User Interface Devices System
b Password
~ Firmware Update r— Firmware Update
v
Snapshot Current Version: WESS 1.05-INTL (£180W;t220W;mt180W;a180W;t68W)
+ Appliance Mode -
PP Firmware Type: |Snapshnt h
» UWF )
Firmware Version: [WEBS 1.05-INTL(Snapshof-220WEBSv105-14E v | £
Reboot immediately [no Me
Check Firmware |
* WARNING! This will remove all data you have placed on this machine.
* This setting will take effect after reboot.
Update firmware ‘ | Cancel
Options for Deploying a Snapshot
Item Description

Firmware Version

Click to select the desired snapshot from the Snapshot list.

Reboot immediately

Click to choose whether to restart the system immediately for firmware update
or manually restart the system later.

6. Click Update firmware to confirm your selections. The system will start deploying the snapshot after restart.
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With a Snapshot on a USB Flash Drive
To deploy a system image on your mt180W with a snapshot on a USB flash drive, please do the following:

1. Plug the USB flash drive into a free USB port of the client.
Start up or restart the client.
During the period of POST (Power-On Self-Test), press F7 to enter the Boot Device menu.

Select to boot from the attached USB flash drive.

The Atrust Thin Client Recovery System is launched.

o vk wN

Select USB, and then click Next to continue.

Atrust Thin Client Recovery System

Valid device: /dev/sdb1
USB mount successfully: device=/dev/sdb1

Please choose one source:

7. The recovery system start deploying the snapshot to the client.

8. After completion, click Finish to restart the client.
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4.2.8 Enabling or Disabling the Appliance Mode

The Appliance mode allows your thin client to start up directly with the desired Microsoft Remote Desktop, Citrix
ICA, VMware View or Horizon View session. After existing a session, the client will be turned off.

—)) NOTE
W
« There are two similar but different modes for your thin client:

No. Mode Description

The client will start up directly with the desired
1 Appliance RDP / ICA / View session and turn off after
existing the session.

The client will start up directly with the desired
RDP / ICA / View session and perform the
configured action after existing the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

« For more information on above modes, please refer to sections:

< 4.2.8 on page 45 (Appliance mode)

< 4.5.5 on page 70 (Autostart mode for RDP sessions)

< 4.5.8 on page 98 (Autostart mode for ICA sessions)

<~ 4.5.11 on page 113 (Autostart mode for View sessions)

Enabling the Appliance Mode
To enable the Appliance mode, please do the following:

NOTE

« Ensure that you have configured the connection settings for the desired Microsoft
Remote Desktop, Citrix ICA, VMware View or Horizon View session under
Applications tab. You need to specify which service type and connection settings
entry will be used under the Appliance mode. For detailed instructions, please
see sections:

&)

< “4.5.3 Configuring Basic RDP Connection Settings” on page 58
< "4.5.6 Configuring Basic ICA Connection Settings”on page 83
< “4.5.9 Configuring Basic VMware View Connection Settings” on page 109
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1. On Atrust Client Setup, click System > Appliance Mode.

Atrust Applications User Interface Devices System
b Password
» Firmware Update Basic Settings
v -
Snapshot & Denable Appliance Mode
~ Appliance Mode

¥ UWF

| Save H Cancel

2. Click to check Enable Appliance Mode.
3. Other settings of the Appliance mode appear.

Basic Settings

; M Enable Appliance Mode

‘ Remote Deskiop e
[w7u vl

Application Type:

Use Session:

* To launch Console: Shift+Cirl+Delete
* To toggle RDP fullscreen: Cirl+Alt+Pause
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4. Click drop-down menus to select the application (or service) type: Citrix ICA, Remote Desktop, or
VMware View, and the specific service available in that type.

Basic Settings

E M Enable appliance Mode

| Remote Deskiop ~le

Application Type:
Use Session: ‘W;'U I;.

* To launch Console: Shift+Ctri+Delete

* To toggle RDP fullscreen: Ctri+Alt+Pause

Basic Settings

E M Enable appliance Mode

Application Type: § Citri ICA Ve
[x75P Ve

Use Session:

* To launch Console: Shift+Ctri+Delete

Basic Settings

& M Enable Appliance Mode

Application Type: { VMware View ~lE
[VMHE e

Use Session:

* To launch Console: Shift+Ctri+Delete

5. Click Save to confirm your selections.

6. The system will enter the Appliance mode after restart.

% ) NOTE
- To disable the Appliance mode or to access Atrust Client Setup under the Appliance
mode, please refer to “Disabling the Appliance Mode” on page 48.
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Disabling the Appliance Mode
To disable the Appliance mode, please do the following:

1. Under the Appliance mode, exit the Full Screen mode of the RDP / ICA session, or release the keyboard and
mouse from the View session (virtual desktop):

- To exit the Full Screen mode of the RDP session, press Ctrl + Alt + Pause.

« To exit the Full Screen mode of the ICA session, use the XenDesktop toolbar at the top
(You may not in the Full Screen mode).

« To release the keyboard and mouse from the View session (virtual desktop), press Ctrl + Alt.

NOTE

+ Please note that the View session (virtual desktop) will remain on the background
after you release the keyboard and mouse from the View session (virtual desktop).

i'/

2. Click Ctrl + Shift + Del to launch Atrust Client Setup.

NOTE

i)

+ You cannot access the Taskbar of the client operating system (Atrust ARM Linux)
under the Appliance mode.

3. On Atrust Client Setup, click System > Appliance Mode.
4. Click to uncheck Enable Appliance Mode, and then click Save to apply the change.
5. Return to the current RDP / ICA / View session:

+ To return to the current RDP / ICA session, use Alt + Tab (press and hold Alt, and then press Tab to switch
between different items) to select and restore the current RDP / ICA session.

« Toreturn to the current View session, click any place of the View session (virtual desktop)
on the background.

6. Log off from the current RDP / ICA / View session.

7. The client will shut down then. Restart your client manually.
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4.2,9 Configuring UWF (Unified Write Filter)

Your mt180W is UWF-enabled by default. Unified Write Filter (UWF) is a sector-based write filter intercepting all write

attempts to a protected volume and redirecting those write attempts to a RAM cache. With UWF, all system changes
will only affect the session where the changes are made. After restart, all changes will be discarded.

@ WARNING

« The UWF feature is enabled by factory default. Except for changes to ACS settings,
all the changes made in a session will not be kept after the system restart. Ensure
that you choose the desired settings here before making any changes to the system.

« Anicon in the Notification area of the Taskbar will indicate the current UWF state
of your system. For details, please refer to the description at the end of this section.

To configure the UWF settings, please do the following:

1. On Atrust Client Setup, click System > UWF.
2. Click the State drop-down menu to enable/disable the UWF feature.

Atrust

» Password

Applications | UserInterface | Devices | System

General

» Firmware Update UWF Setting
+ Snapshot

Next State: [Enabled Me
- UWF

Maximum used memory: (640 mB

&
[24 hours Me

When UWF is disabled, warn me every:

* This setting will take effect after reboot.

Save Cancel

3. Click to select other options if needed.

<’/ TIP
+ You can change the maximum memory size used only when UWF is disabled.
Disable UWF first, and then change the memory size used. A restart is required
when you switch the UWF state.
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UWF Options

Item Description
Next State Click to enable / disable UWF. A restart is required for switching.
Maximum used memory Click to select the maximum memory used for UWF.

When UWF is disabled, warn me every Click to select how often the system warns you when UWF is disabled.

4. Click Save to confirm your selections.

5. You may need to restart the system for the change(s) to take effect.

@ WARNING

+ You need to restart the system for switching between the UWF enabled and
disabled states. An icon will appear in the Notification area of the Taskbar to indicate
the current UWF state of the system. The following table provides a description of

eachicon:
Icon Name Description

The UWF is currently enabled. Except for

ra Green Lock changes to ACS settl_ngs, all the oth'er ch_anges
made to the system in current session will not
be kept after the system restart.

Fall Oranage Lock The UWF state was changed and will take

e | 9 effect after the system restart.

Red Lock The UWF is currently disabled.

TIP

+ When UWF is enabled, you can move the mouse pointer over the UWF icon to
check currently free memory (overlay) for UWF. A tooltip as below will be shown.

)

WVolume C: is protected by write filter
Overlay: 628 MB free of 640 MB

= Ial?;l I‘:::I LD F

6/10/2014

NOTE

+ As a thin client device, your mt180W is mainly for access to remote or virtual
desktops on servers. With the limited and protected (UWF-enabled) hard disk space,
it's not recommended to save data on your mt180W. Instead, you can use storage
spaces over remote / virtual desktops, removable storage devices, or networks.

[l

+ In case that you need to copy a file to the protected volume, ensure that its size is
smaller than the free memory (overlay) space. Otherwise, your system may have
unexpected results or become unresponsive.
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4.3 Configuring External Device Settings

4.3.1 Devices Tab Overview

Devices tab enables you to configure settings for external devices of clients. To access available settings of Devices
tab, click the tab on Atrust Client Setup.

Devices Tab Overview

Atrust Applications | User Interface | Devices | System
“00..0..00 o+ USB Storage
» Audio [y USB Storage eee ooooo-oog
Configure USB storage

@" Audio
Ml Configure audio device

Interface Elements

No. Name Description
1 Navigation area Click to select a setting item under Devices tab.
2 Configuration area Configures setting values when a setting item is selected.

4.3.2 Available Settings at a Glance

Tab Setting Icon Description Section Page

USB Storage 'LP Click to configure settings for USB storage devices. 4.3.3 52

Devices

Audio Q“' Click to configure settings for audio devices. 4.3.4 53
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4.3.3 Configuring Settings for USB Storage Devices

To configure settings for USB storage devices, please do the following:

1. On Atrust Client Setup, click Devices > USB Storage.

Atrust Applications User Interface

Devices System
~ USB Storage
+ Audio USE Storage
Security Options Enable USE Storage Ve

* This setting will take effect immediately. If you change this setting while a USB storage device is attached, the
change applies to the device only after it's replugged.

| Save Cancel

2. Click the drop-down menu to select the desired setting. Three options are available: Enable USB Storage,
Read-Only Access, and Disable USB Storage.

5/ NOTE

- When Enable USB Storage is selected, settings of RDP / ICA connection entries
under Applications tab may affect if you can use mapped USB storage devices in
remote / virtual desktop sessions. For details, please refer to sections:

< "4.5.5 Configuring Advanced RDP Connection Settings” on page 70
< "4.5.8 Configuring Advanced ICA Connection Settings” on page 98

« When Disable USB Storage is selected, Citrix ICA and VMware View / Horizon View
sessions may still allow users to use locally attached USB storage devices
through redirection. To really prevent the use of USB storage devices in virtual
desktop sessions, some configurations in Citrix and VMware service delivery
environments are required.

3. Click Save to store your change.
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4.3.4 Disabling or Enabling Attached Audio Devices

To disable/enable attached audio devices, please do the following:

%J NOTE

- If you disable locally attached audio devices, client users are not allowed to perform
audio playback or recording with these devices in an RDP / ICA / View session.

+ To perform audio playback or recording with local audio devices in an RDP / ICA /
View session, you need to enable locally attached audio devices here (the Audio
setting item under Devices tab) and configure audio related settings (if any) in the
RDP /1CA / View connection settings. For detailed instructions, please
refer to sections:

< “4.5.5 Configuring Advanced RDP Connection Settings” on page 70
< “4.5.8 Configuring Advanced ICA Connection Settings” on page 98
< “4.5.11 Configuring Advanced View Connection Settings”on page 113

1. On Atrust Client Setup, click Devices > Audio.

Atrust Applications | User Interface | Devices | System
—
» USB Storage
~ Audio Audio
& ¥ Enable System Audio Device
* This setting will take effect after reboot.

| Save H Cancel

2. Click to check/uncheck Enable System Audio Device.

3. Click Save to confirm your selection.

% NOTE

- The change will not take effect until the client has been restarted.
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4.4 Configuring User Interface Settings

4.4.1 User Interface Tab Overview

User Interface tab enables you to configure settings for the user interface of clients. To access available settings of
User Interface tab, click the tab on Atrust Client Setup.

User Interface Tab Overview

Atrust Applications | User Interface | Devices | System

“00..00.00 o+ Desktop

¢ Desktop

I . eee
Configure desktop icons

Interface Elements

No. Name Description
1 Navigation area Click to select a setting item under User Interface tab.
2 Configuration area Configures setting values when a setting item is selected.

4.4.2 Available Settings at a Glance

Tab Setting Icon Description Section Page

User Desktop rd Click to configure the display of standard

Interface (&1 desktop shortcuts for quick service access. D o5
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4.4.3 Configuring the Display of Standard Desktop Shortcuts for Quick Access

The Desktop setting enables you to display or hide the standard desktop shortcuts for service quick access. Three
standard desktop shortcuts are available: Citrix Receiver, Remote Desktop Connection, and VMware Horizon
View Client, separately for quick service access of Citrix XenApp / XenDesktop / VDI-in-a-Box, Microsoft Remote
Desktop / Remote Application (RemoteApp), and VMware View / VMware Horizon View.

%-1, o-a
_,i)l F ]

Remote Desktop Connection Citrix Receiver VMware Horizon View Client

TIP
%
+ You can use these standard desktop shortcuts to quickly access services.
For detailed instructions, please refer to chapter 3 “Getting Started” on page 15.

E/ NOTE

+ You can also customize your desktop shortcuts for quick service access. For detailed
instructions on how to create and customize your own desktop shortcuts, please
refer to section “4.5 Configuring Service Access Settings” on page 56.

To display or hide the standard desktop shortcuts for quick service access, please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

Atrust Applications User Interface Devices System
Genera

~ Desktop

Desktop Icons

& M Remote Desktop Connaction

& M citrix Receiver

& Mvmware view Client

Save Cancel

2. Click to check/uncheck Remote Desktop Connection, Citrix Receiver, or VMware View Client.

3. Click Save to apply.
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4.5 Configuring Service Access Settings

4.,5.1 Applications Tab Overview

Applications tab enables you to configure settings for service access on clients. To access available settings of
Applications tab, click the tab on Atrust Client Setup.

Applications Tab Overview

Atrust Applications | User Interface | Devices | System
“ocooooooa o * Remote Desktop
¥ Citrix ICA | Remote Desktop Available Sessions: 0 eee eeccccce g
o Configure RDP (Remote Desktop Protocol) connection settings
» VMware View

» Web Browser e  Citrix ICA Available Sessions: 0

Configure Citrix ICA connection settings

g vMware view Available Sessions: 0
T Configure VMware View connection settings

,: i Web Browser Available Sessions: 0
Configure local browser settings

Interface Elements

No. Name Description

I Click to select a setting item under Applications tab or to select a setting
1 Navigation area A
entry under a selected setting item.

2 Configuration area Configures setting values when a setting item or entry is selected.
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4.,5.2 Available Settings at a Glance

Tab Setting Icon Description Section Page
Remote Click to configure RDP (Remote Desktop Protocol) 4.5.3
Deskto ;‘2-. connection settings and create access shortcuts 4.5.4 58
P W on the desktop for RDP sessions. 4.5.5
Click to configure Citrix ICA (Independent 456
Citrix ICA Computing Architecture) connection settings and 457 83
create access shortcuts on the desktop for
X 4.5.8
ICA sessions.
Applications
Click to configure VMware View connection 4.5.9
VMware View o a settings and create access shortcuts on the 4.5.10 109
— desktop for View sessions. 4.5.11
P Click to configure browser session settings
Web Browser U and create access shortcuts on the desktop for 4.5.12 115

browser sessions.
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4.,5.3 Configuring Basic RDP Connection Settings

The Remote Desktop setting allows you to configure RDP (Remote Desktop Protocol) connection settings and
create shortcuts on the desktop or Start screen for Remote Desktop services. You can access services for work simply
through these shortcuts.

NOTE

« For more information on Microsoft Remote Desktop services, please visit Microsoft
website at www.microsoft.com.

(W)

Three connection types are available:

Connection Type Description Page
Remote Desktop Select to access remote desktops/applications. 59
Remote Web Access  Select to access remote desktops/applications through a Web browser. 61

Web Feed Select to access remote applications through published Start screen tiles. 63


www.microsoft.com
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Connection Type: Remote Desktop

To quickly configure RDP connection settings for Remote Desktop connection type, please do the following:
1.

On Atrust Client Setup, click Applications > Remote Desktop.

l\tl’LISI: Applications | User Interface Devices System
” + Add = Delete
~ Session Name
~ Remote Desktop
» Citrix TCA

Server Address

Connection Type
b VMware View
» Web Browser

O

2. The RDP Connection list appears in the Configuration area.

@ NOTE

- If you haven't create any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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Atrust Applications | User Interface Devices | System
Navigat 5
General |Options |RD Gateway
~ Remote Desktop
» Citrix ICA [~ Server Settings
b VMware View -
Session Name: “‘ |h
» Web Browser N
Server Address: “‘ |h_
Connection Type: ‘Remcle Desktop ElL
Connection Quality: [Very Fast (LAN) Ve
Server Authentication: [Connectand don'twam me Ve
[~ Login Settings
Username: [ &
Password: [ &
Domain: ‘ ||.
[~ Common Settings
Autostart When Startup: [No
On Application Exit: ‘ Do Nothing h_

Save H Cancel

4. On General sub-tab, type in the session name and the server/virtual machine address under the Server
Settings section.

@ NOTE

« The red asterisks indicate the required fields.

+ The remote computer can be a physical server or a virtual machine. Please visit
Microsoft’s websites at www.microsoft.com or support.microsoft.com for more
information.

5. Click Save to add this RDP connection entry.

6. The shortcut for Remote Desktop connection is automatically created on the desktop.

@ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.5.5 Configuring Advanced RDP Connection Settings” on page 70.


www.microsoft.com
support.microsoft.com
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Connection Type: Remote Web Access

To quickly configure RDP connection settings for Remote Web Access connection type, please do the following:

@ NOTE

+ Your mt180W supports only RD Web Access based on Windows Server 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, click Applications > Remote Desktop.

l\tl'LISI: Applications | User Interface Devices System
” + Add = Delete

~ Session Name
~ Remote Desktop

» Citrix TCA

Server Address
b VMware View

Connection Type
» Web Browser

O

2. The RDP Connection list appears in the Configuration area.

@ NOTE

- If you haven't create any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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Atrust

~ Remote Desktop

Applications | User Interface Devices | System

General |Options |RD Gateway

¥ Citrix ICA
b VMware View

» Web Browser

[~ Server Settings

Session Name:
Connection URL:

Connection Type:

Remote Web Access o

— Common Settings
Autostart When Startup: [No Me
©On Application Exit: [Do Nothing Ve

Save H Cancel

4. On General sub-tab, click the Connection Type drop-down menu to select Remote Web Access.

5. Type in the session name and connection URL through which Web-based remote applications/desktops
is accessible.

@ NOTE

+ The red asterisks indicate the required fields.

« Consult your IT administrator for the appropriate connection URL.

6. Click Save to add this RDP connection entry.

7. The shortcut for Remote Web Access connection is automatically created on the desktop.

@ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.5.5 Configuring Advanced RDP Connection Settings” on page 70.
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Connection Type: Web Feed
To quickly configure RDP connection settings for Web Feed connection type, please do the following:

@ NOTE

+ Your mt180W supports only RD Web Access based on Windows Server 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, click Applications > Remote Desktop.

l\tl'LISI: Applications | User Interface Devices System
” + Add = Delete
~ Session Name
~ Remote Desktop
» Citrix TCA

Server Address

b VMware View

Connection Type
» Web Browser

O

2. The RDP Connection list appears in the Configuration area.

@ NOTE

- If you haven't create any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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Atrust Applications | User Interface Devices | System
Navigat 5
General |Options |RD Gateway
~ Remote Desktop
» Citrix ICA [~ Server Settings
b VMware View -
Session Name: “‘ |L
» Web Browser N
Web Feed URL: “‘ |L
Connection Type: tWeb Feed o

— Login Settings

Username: ’“‘

Passwaord: “‘

Domain: “‘

— RemoteApp and Desktop Connections

Update Now
Connection name:
Summary:

Last Update:

Save H Cancel

4. On General sub-tab, click the Connection Type drop-down menu to select Web Feed.

5. Type in the session name, the Web Feed URL through which remote applications is accessible, and your
credentials for Web Feed.

%J’ NOTE

+ The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate Web Feed URL.

6. Click Update Now in the RemoteApp and Desktop Connections section. After completion, the result will be
shown as blow in that section.

— RemoteApp and Desktop Connections

Update Mow

Connection name: Work Resources
Summary: 3 applications, 0 desktops
Last Update: Mon Aug 11 2014 18:47:51

7. Click Save to add this RDP connection entry.

8. The application tiles for Web Feed are automatically created on the Start screen.

3’/ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“4.5.5 Configuring Advanced RDP Connection Settings” on page 70.
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4.5.4 Accessing Remote Desktop Services

Connection Type: Remote Desktop
To access Remote Desktop services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

= NOTE
=i
+ You can also access Remote Desktop services through the standard desktop
shortcut Remote Desktop Connection. For detailed instructions on how to access

services via this standard shortcut, please refer to section “3.3 Accessing Microsoft
Remote Desktop Services” on page 24.

2. Follow the on-screen instructions and provide required credentials if needed.

3. The desired remote desktop will be displayed on the desktop in full screen (by default).

—1-) NOTE
5/
+ The connection type of Remote Desktop also allows you to launch application-

only sessions; only a specific application is launched rather than a full desktop. For

details, please refer to “4.5.5 Configuring Advanced RDP Connection Settings” on
page 70.

Example: Windows MultiPoint Server 2012

WMsU1 &
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Example: Windows Server 2012

=8 Windows Server 2012R2

Windows S

1932

[ I A5 gaans

Example: Windows 8 Enterprise

Trending
Mid o

One Month
& +109% 1l

5

New York City

Clear

20774

(M
1

=

a




Connection Type: Remote Web Access
To access remote applications/desktops, please do the following:

1. Double click the created shortcut on the desktop.

2. A window appears prompting for credentials.

Work Resources
RemoteApp and Desktop Connecion

Configuring Client Settings

Configuring Service Access Settings

Domaimusername: [
Passwor: [

Security(show explanation)
@®  Thisis a public or shared computer

O Thisis a private computer

To protect against unauthorized access, your RD Web
matically time out aftera pericd
ion ends, refresh your browser

‘@/ NOTE

« A warning message about security might appear. Consult your IT administrator
for details and ensure the connection is secure first. To by pass, click Continue to

this website.

« Click to select Allow to enable ActiveX Control when a popup message appears at

the bottom of the page.

3. Provide your credentials, and then click Sign in.
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4. Click to select RemoteApp and Desktops or Connect to a remote PC.

Work Resources
RemteApp and Desktop Comnection

Work Resources
RemeteApp snd Desktop Connection

Desktops

Enter the name of

Connect to:
s
e |

5. Clickicons or follow the on-screen instructions to launch applications or desktops.
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Connection Type: Web Feed
To access remote applications, please do the following:

1. On Start screen, click the application tile to launch an application.

Start

e B

Intemet Explorer | File Explorer

2. The application is opened on the desktop.

Adobe Reader
Fle Edit View Window Help

B FxeBe | 0 1 Tools | Sign | Comment

v Export PDF.

Adobe ExportPDF
Convert PDF il to Word or Excel
onine.

Select POF File:

Open a Recent File Adobe Online Services

B9 My Computer.. ,%] Convert PDF to Word or Excel
4

2 coneros

B3 Adobat.com

@ Mosila Firefox tart Page.

e Tool: Help

DS

Sign in

e
pre—
“Eeoa
i

£ Sign in with Facebook

G,
>y
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4,5.,5 Configuring Advanced RDP Connection Settings

The table below provides a description of each setting item for RDP connections. Please see this table to configure
advanced settings and customize your mt180W desktop shortcuts or Start screen tiles for service access.

NOTE

(]

« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Remote Desktop

%/ NOTE

- For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 77.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 79.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Desktop sessions.
Type in the computer name or IP address of the server/virtual machine where to
Sever Address deliver a Remote Desktop session.
This table only provides descriptions for available settings when
Remote Desktop is selected.
Three connection types are available:
Option Description
Connection Type Remote Desktop Provides access to remote desktops/applications.

Provides access to remote desktops/applications
Remote Web Access through a Web browser (Internet Explorer).

Provides access to remote applications through
Web Feed published Start screen tiles.

Select the setting that best describes the quality of your network connection.

Three options are available: Very Fast (LAN), Fast (Broadband), and
Slow (Modem).

Connection Quality
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Server Authentication

Select what to do next if the client cannot verify the identity of the remote
computer. Three options are available: Connect and don’t warn me,
Warn me, and Do not connect.

Option Description

Connect and don't Connects anyway without any warning.

warn me
Warns and allows users to choose whether t
Warn me a and allo o choo (o]
connect or not.
Do not connect Disallows the connection.

Login Settings

Item Description

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Type in the domain of the server.

Domain

NOTE: Leave this field blank if the server doesn’t belong to any domain.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Remote Desktop session automatically or not when
Windows Embedded starts.

If Yes is selected, every time when you log in to the system, the Remote
Desktop session will be opened automatically.

On Application Exit

Select what to do when a Remote Desktop session is ended. Four options are
available: Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Remote Desktop session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Options Sub-tab

Programs

Item

Description

Start the following program
on connection

Click the drop-down menu to enable/disable the Application mode. You can use
this option to select the session type. Two remote session types are available:

e Remote Desktop (when the Application mode is disabled)
e Remote Application (when the Application mode is enabled)

NOTE: Remote Application sessions are Remote sessions used to access only
specific applications rather than full desktops.

NOTE: Before you can open a Remote Application session, you need to add the
desired application to the RemoteApp Programs list with RemoteApp
Manager on the application hosted server. For detailed instructions on
how to add a desired application to the RemoteApp Programs list on the
server, please visit Microsoft Support website at support.microsoft.com.

Start in the following folder

Type in the location of the desired application (on the host server) if
Start the following program on connection is enabled.

NOTE: You can type in the location/path of the desired application in this field,
and specify only the name of the application in Program path and file
name (the next field). Or, you can type in the full path and name of the
application in Program path and file name, and leave this field empty.

Program path and file name

Type in the path and name of the desired application if Start the following
program on connection is enabled.

Remote APP Format Example

Windows Media Player C:\Programs Files (x86)\Windows Media Player\wmplayer.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32

NOTE: the file extension can be omitted.

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Four options are available: 15 Bit, 16 Bit, 24 Bit, and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: You can configure the upper limit of the color depth for a Remote Desktop
session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.

Resolution

Click the drop-down menu to select the desired display resolution on a Remote
Desktop session. Twelve options are available: Fullscreen, 1920x1200,
1920x1080, 1680x1050, 1400x1050, 1440x900, 1280x1024, 1280x768,
1280x720, 1024x768, 800x600, and 640x480.
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Multi-Monitor

Click the drop-down menu to enable/disable multiple displays in a Remote
Desktop session.

Display the connection bar
when I use the full screen

Click the drop-down menu to select if the Connection bar is displayed or not in
full-screen mode.

Connection Settings

Item

Description

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add the desired local or network printer(s) for your thin
client first, and then enable this feature here to use that printer in a
Remote Desktop session.

NOTE: To add a local or network printer for your Windows Embedded-based thin
client, go to Control Panel, click Hardware and Sound > Devices and
Printers > Add a printer, and then follow the on-screen instructions to
add the desired local or network printer.

Clipboard Redirection

Click the drop-down menu to enable/disable Clipboard redirection.

NOTE: When Enable is selected, Clipboard can be used across local and remote
desktops (in both directions).

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in @ Remote Desktop session.

Port Mapping

Click the drop-down menu to enable/disable port mapping.

When Enable is selected, users can access attached devices using locally
available ports, in a Remote Desktop session.

NOTE: The types and availability of device ports on thin clients may vary,
depending on your product models.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the computer sounds and audio playback
setting in a Remote Desktop session. Three options are available: Bring to this
computer, Do not play, and Leave at remote computer.

Option Description

Allows computer sounds and audio playback in a
Remote Desktop session using locally attached
audio devices.

Bring to this computer

Disables computer sounds and audio playback

Do not play in a Remote Desktop session.

Leave computer sounds and audio playback at

Leave at remote computer the remote computer.
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Remote Audio Recording

Click the drop-down menu to configure the audio recording setting in a Remote
Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description

Allows audio recording in a Remote Desktop

Recording from this computer session using locally attached audio devices.

Disables audio recording in a Remote Desktop

Do not record session using locally attached audio devices.

NOTE: When Leave at remote computer is selected on the drop-down menu
of Remote Audio Playback, this setting item will be grayed out.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On this computer, On the remote computer,
Only when using the full screen.

Drives

Click the drop-down menu to enable/disable locally attached drives in a Remote
Desktop session.

Supported plug and play
devices

Click the drop-down menu to enable/disable the supported plug and play devices
in @ Remote Desktop session.
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RemoteFX USB redirection

Click to enable/disable locally attached RemoteFX USB devices.

NOTE: To use RemoteFX USB devices in remote desktops, you need to configure
the policy setting about device redirection to allow RemoteFX USB Device
Redirection as well. To do so, please follow the steps below:

1. Log in to your mt180W with an administrative account.

2. Disable UWF (Unified Write Filter) through Atrust Client Setup
(See “4.2.9 Configuring UWF (Unified Write Filter)” on page 49).

3. On the desktop or Start screen, move your mouse to the bottom-right
corner. The charms appear.

4. Click Search to select the Search charm.

5. Type group policy in the Search charm, and then click Settings.
Edit group policy appears on the left.

Click to select Edit group policy. carch

Settings

. Group Policy
Settings

Apps
Fo) Settings

7. On the opened window, select Computer Configuration >
Administrative Templates > Windows Components > Remote
Desktop Services > Remote Desktop Connection Client >
RemoteFX USB Device Redirection > Allow RDP redirection of
other supported RemoteFX USB devices from this computer.

8. Select Enabled and to which users this setting applies: Administrators
Only or Administrators and Users, and then click OK.

9. Enable UWF through Atrust Client Setup.
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RD Gateway Sub-tab

Connection Settings

Item Description

Click the drop-down menu to choose if a RD Gateway server is used,
automatically detected, or manually configured. Three options are available:
Automatically detect RD Gateway server settings, Use these RD Gateway
server settings, and Do not use an RD Gateway server.

RD Gateway Server Settings

Type the IP address / URL / FQDN of the RD Gateway server.

Sever Name
NOTE: Consult your network administrator for details.

Click the drop-down menu to select the logon method. Three options
are available: Allow me to select later, Ask for password (NTLM), and
Smart card.

Option Description
Users can select a logon method while
Logon method Allow me to select later connecting to the server.

Users will be prompted for a password while

Ask for password (NTLM) connecting to the server.

Users will be prompted for a smart card

Smart card while connecting to the server.

Bypass RD Gateway server for Check to prevent traffic to and from local network addresses from being routed
local addresses through the RD Gateway server and make a connection faster.

Logon Settings

Item Description

Use my RD Gateway credentials | Check to use the same set of credentials for authenticating to both the RD
for the remote computer Gateway server and the remote computer.
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Settings for the Connection Type of Remote Web Access

=) NOTE

al

General Sub-tab

- For descriptions of settings for the connection type of Remote Desktop, please
refer to “Settings for the Connection Type of Remote Desktop” on page 70.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 79.

Server Settings

Item

Description

Session Name

Type in the name for Remote Web Access sessions.

Connection URL

Type in the connection URL through which RD Web Access is available.

Connection Type

This table only provides descriptions for available settings when Remote
Web Access is selected.

Three connection types are available:

Option Description

Remote Desktop Provides access to remote desktops/applications.

Provides access to remote desktops/applications

Remote Web Access through a Web browser (Internet Explorer).

Provides access to remote applications through

Web Feed published Start screen tiles.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Remote Desktop session automatically or not when
Windows Embedded starts.

If Yes is selected, every time when you log in to the system, the Remote
Desktop session will be opened automatically.

On Application Exit

Select what to do when a Remote Desktop session is ended. Four options are
available: Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Remote Desktop session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Options Sub-tab

NOTE

i)

- No options are available under the Options sub-tab in the connection type of
Remote Web Access.

RD Gateway Sub-tab

NOTE

(i)

- No options are available under the RD Gateway sub-tab in the connection type of
Remote Web Access.
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Settings for the Connection Type of Web Feed

=) NOTE

al

- For descriptions of settings for the connection type of Remote Desktop, please
refer to “Settings for the Connection Type of Remote Desktop” on page 70.

- For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 77.

General Sub-tab

Server Settings

Item Description

Session Name

Type in the name for Web Feed sessions.

Web Feed URL

Type in the URL through which RD Web Feed is accessible.

This table only provides descriptions for available settings when Web Feed
is selected.

Three connection types are available:

Option Description

Connection Type Remote Desktop Provides access to remote desktops/applications.

Provides access to remote desktops/applications

Remote Web Access through a Web browser (Internet Explorer).

Provides access to remote applications through

Web Feed published Start screen tiles.

Login Settings

Item Description

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Type in the domain of the server.

Domain

NOTE: Leave this field blank if the server doesn’t belong to any domain.

RemoteApp and Desktop Connection

Item

Description

Update Now

Click to fetch and update the published applications list from the server.

79



80

Configuring Client Settings
Configuring Service Access Settings

Options Sub-tab

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Four options are available: 15 Bit, 16 Bit, 24 Bit, and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: You can configure the upper limit of the color depth for a Remote Desktop
session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.

Resolution

Click the drop-down menu to select the desired display resolution on a Remote
Desktop session. Twelve options are available: Fullscreen, 1920x1200,
1920x1080, 1680x1050, 1400x1050, 1440x900, 1280x1024, 1280x768,
1280x720, 1024x768, 800x600, and 640x480.

Multi-Monitor

Click the drop-down menu to enable/disable multiple displays in a Remote
Desktop session.

Display the connection bar
when I use the full screen

Click the drop-down menu to select if the Connection bar is displayed or not in
full-screen mode.

Local Resources Settings

Item

Description

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On this computer, On the remote computer,
Only when using the full screen.
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RemoteFX USB redirection

Click to enable/disable locally attached RemoteFX USB devices.

NOTE: To use RemoteFX USB devices in remote desktops, you need to configure
the policy setting about device redirection to allow RemoteFX USB Device
Redirection as well. To do so, please follow the steps below:

1. Log in to your mt180W with an administrative account.

2. Disable UWF (Unified Write Filter) through Atrust Client Setup
(See “4.2.9 Configuring UWF (Unified Write Filter)” on page 49).

3. On the desktop or Start screen, move your mouse to the bottom-right
corner. The charms appear.

4. Click Search to select the Search charm.

5. Type group policy in the Search charm, and then click Settings.
Edit group policy appears on the left.

Click to select Edit group policy. carch

Settings

. Group Policy
Settings

Apps
Fo) Settings

7. On the opened window, select Computer Configuration >
Administrative Templates > Windows Components > Remote
Desktop Services > Remote Desktop Connection Client >
RemoteFX USB Device Redirection > Allow RDP redirection of
other supported RemoteFX USB devices from this computer.

8. Select Enabled and to which users this setting applies: Administrators
Only or Administrators and Users, and then click OK.

9. Enable UWF through Atrust Client Setup.
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RD Gateway Sub-tab

NOTE

i)

- No options are available under the RD Gateway sub-tab in the connection type of
Remote Web Access.
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4,5.6 Configuring Basic ICA Connection Settings

The Citrix ICA setting allows you to configure ICA connections for Citrix services and create shortcuts on the local
desktop for service access. You can access virtual desktops and applications for work simply through these shortcuts.

%J’ NOTE

+ For more information on Citrix desktop virtualization solutions, please visit Citrix
website at www.citrix.com or Citrix Knowledge Center at support.citrix.com.

%J NOTE

+ You can also access Citrix services through the Internet Explorer or the standard
desktop shortcut Citrix Receiver. For detailed instructions on how to access
services via this standard desktop shortcut, please refer to section “3.2 Accessing
Citrix Services” on page 18.

«+ The following topics in this section will guide you through the steps of creating and
customizing your own service access shortcuts on the desktop and Start menu.

- To configure connection settings for Citrix VDI-in-a-Box, you can choose Web
Logon or XenDesktop connection type.

Connection Type: Web Logon

To quickly configure ICA connection settings for the connection type of Web Logon, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust Applications User Interface Devices System
+ Add = Delete
~ Session Name

Server Address Connection Type
» Remote Desktop

> Citrix ICA
b VMware View
* Web Browser

[0
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@'/ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, leave the connection type as Web Logon as default, and then type in the desired
session name and the IP address / URL / FQDN of the server through which Citrix services are accessible
under the Server Settings section.

l\l:l'ust Applications | User Interface Devices System
S —
* Remote Deskiop
* Citrix ICA — Server Settings
VM Vi N
ware View Session Name: “‘ ‘h
» Web Browser )
Connection Type: ‘Web Lagon Eh
Server Address: X‘ ‘L‘

— Common Settings

Autostart When Startup: ‘ No Eh‘

on Application Exit: [Do nothing Ve

Save || Cancel

@ NOTE

 The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

5. Click Save to add this ICA connection entry. The access shortcut will be created automatically on the desktop.

@ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 98.
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Connection Type: XenDesktop
To quickly configure ICA connection settings for the connection type of XenDesktop, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust

Applications | User Interface | Devices | System

; + Add = Delete

~ Session Name

» Remote Desktop
> Citrix ICA

Server Address Connection Type

b VMware View

} Web Browser

o

@ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, click the Connection Type drop-down menu to select XenDesktop.
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Atrust Applications | User Interface Devices System
Navigator E——
S—
* Remote Deskiop
* Citrix ICA — Server Settings
» VMware View -
Session Name: 8 &
» Web Browser R
Connection Type: {XenDeskiop ivlg
Server Address: “‘ ‘L
Username: X‘ ‘L‘
Password: Bl &
Domain: X‘ ‘h‘
Desktop Group: R X‘ ‘;
— Common Settings
Autostart When Startup: ‘ No Eh‘
On Application Exit: ‘ Do nothing h‘

Save || Cancel

5. Type the session name, the IP address / FQDN of the server through which XenDesktop is accessible,

user credentials, the domain of the server, and then click the Search icon ﬂ) to discover available
desktop groups.

% NOTE

- The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

« The Search icon works only when required data (fields marked with a red asterisk)
have been provided.

6. Upon completion, the Search Dialog window appears for you to select the desktop group. Click the
drop-down menu to select the desired desktop group, and then click Select to confirm.

Search dialog _‘

Desktop Group :

WUS Deskiops E|
)

Select || Cancel

7. The selected desktop group name automatically appears in the Desktop Group field.

8. Click Save to confirm. The access shortcut will be created automatically on the desktop.

%J‘ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 98.
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Connection Type: XenApp
To quickly configure ICA connection settings for the connection type of XenApp, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust

Applications | User Interface | Devices | System

; + Add = Delete

~ Session Name

» Remote Desktop
> Citrix ICA

Server Address Connection Type

b VMware View

} Web Browser

o

@ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, click the Connection Type drop-down menu to select XenApp.
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Atrust Applications User Interface Devices System
Navigator E——
General | Application
* Remote Deskiop
* Citrix ICA — Server Settings
» VMware View -
Session Name: “‘ ‘h
» Web Browser N
Connection Type: {XenApp Ve
Server Address: “‘ ‘L
Username: X‘ ‘;
Password: “‘ ‘;
Domain: X‘ ‘h‘
Application Name: el = &
— Common Settings
Autostart When Startup: ‘ No Eh‘
on Application Exit: ‘ Do nothing 4]

Save || Cancel

5. Type the session name, the IP address / FQDN of the server through which XenApp is accessible, user
credentials, the domain of the server, and then click the Search icon to discover available applications.

% NOTE

- The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

« The Search icon works only when required data (fields marked with a red asterisk)
have been provided. If your XenApp server doesn’t belong to any domain, just type
its computer name in the Domain field.

6. Upon completion, the Search Dialog window appears for you to select the application. Click the drop-down
menu to select the desired application, and then click Select to confirm.

Search dialog

Application Name :
EPDF Reader X

Select || Cancel |

7. The selected application name automatically appears in the Application Name field.

8. Click Save to confirm. The access shortcut will be created automatically on the desktop.

%J‘ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 98.
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Connection Type: Server Connection
To quickly configure ICA connection settings for the connection type of Server Connection, please do the following

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

Atrust

Applications | User Interface | Devices | System

; + Add = Delete

~ Session Name

» Remote Desktop
> Citrix ICA

Server Address Connection Type

b VMware View

} Web Browser

o

@ NOTE

- If you haven't create any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.

4. On General sub-tab, click the Connection Type drop-down menu to select Server Connection.
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Atrust Applications | User Interface Devices System
General Appicahon

* Remote Deskiop

* Citrix ICA — Server Settings

$ Viware View Session Name: “‘

» Web Browser

Connection Type: {Server Conneclion ivle

Server Address: 3

Username: X‘

Password: “‘

Domain: X‘

— Common Settings

Autostart When Startup: [No Me
On Application Exit: ‘ Do nothing Eh‘
Save | | Cancel

5. Type the session name, the IP address / FQDN of the server, user credentials, and the domain of the server.

@ NOTE

« The applicable or best suitable information type of the server side may vary with
your Citrix environment. Consult your IT administrator for more information.

+ Only connections to XenApp servers are supported by this connection type.

6. Click Save to confirm. The access shortcut will be created automatically on the desktop.

@'/ NOTE

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“4.5.8 Configuring Advanced ICA Connection Settings” on page 98.



Configuring Client Settings

Configuring Service Access Settings

4.,5.7 Accessing Citrix Services

For Connection Types of XenDesktop, XenApp, and Server Connection
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

@ NOTE

- You can also access Citrix services through the standard desktop shortcut Citrix
Receiver. For details on how to access services via the standard desktop shortcut,
please refer to section “3.2 Accessing Citrix Services” on page 18.

2. The desired application or desktop is displayed on the screen.

For Connection Types of Web Logon
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

@ NOTE

+ You can also access Citrix services through the standard desktop shortcut
Citrix Receiver. For details on how to access services via the standard desktop
shortcut, please refer to section “3.2 Accessing Citrix Services” on page 18.

2. The Web browser is launched with the Citrix Logon screen.

Logon Screen Example: XenApp 6.5 Platinum

LY ) © nitp:/xa6Sp coxpac/Citrix/XenApp/auth/login.aspx P~ B0 || @ Citrix XenApp - Logon x !

e
e CITRIX

Citrix XenApp

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.
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Logon Screen Example: XenDesktop 5.6 Platinum

L3P © hitp://ddexd5bp.cix poc/Citrix/ DesktopWeb/auth/login.es O = B & || @ citri XenDesktop - Logon

Citrix XenDesktop

Log on

User name:
. Password:
. € =,

Domain:

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

Logon Screen Example: XenApp and XenDesktop 7.5 Platinum

CENED) B hti://xa75p.ctepoc Citrix/Storeleb,

CitrixReceiver
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3. Type in the required credentials and domain name, and then click Log On.

‘ ) NOTE

- If your service-hosted server doesn’t belong to any domain, type in the server name
instead if required.

4. Click to select the desired application(s) or desktop(s).

Screen for On-Demand Applications: XenApp 6.5 Platinum

RSB O hitp://192.168.0.11/Citrix/XenApp/site/defaultaspr 2 ~ B & || @ Citrix XenApp - Applications fr K 18
3 & . ’
Search .
2 E  Logged onas:crxuz Messages Settings Log OFf ~ CITRIX

@

Motepad PDF reader PPT viewer

Hint Click Reconnect to resume any pausad resources.
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Screen for On-Demand Desktops: XenDesktop 5.6 Platinum

&~ @\@ hitp://192.168.0.5/Citrx/DesktopWeb/ste/directLaunch. O = B & || @ Citrx XenDesktop | ‘ X

Screen for On-Demand Applications: XenApp 7.5 Platinum

Citrix Receiver
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Screen for On-Demand Desktops: XenDesktop 7.5 Platinum

CitrixReceiver

5. The selected application(s) or desktop(s) will be displayed on the screen.

Example: Desktop Delivered by XenDesktop 5.6 Platinum
Windows 7 Ultimate

Welcome to your Citrix XenDesktop.

Any Device

Access is easy from any PC,
Mac, smartphone or tablet
The choice s yours.

Welcome to the virtual workstyle

High Definition

Blazing speed and stunning
graphics over any network,
er - powered by Citrix XenDesklop. including Wi-Fi or 3G.

Your desktop, apps and documents at your fingertips

o [ cee |

N D)
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Example: Desktop Delivered by XenDesktop 7.5 Platinum
Windows Server 2008 R2

Example: Applications Delivered by XenApp 6.5 Platinum
PowerPoint Viewer, Adobe Reader, and Skype

a
o )| @ hitp//xa65p ceepocyCi site/defaultaspx £ - 20| @ ciixxenrpp - Applcations x| | @ @

Window_Help

e BB EGEEE]0

Adobe ExportPDF
Convert PDF files to Word or Excel
online

Select PDF File:

Open a Recent File Adobe Online Services
B W Computer.. A, ComenTe

B3 Adobatcom
@ Creste POF

G2 sendand Trck s onlne ST

@ Get Documents Signed

-l 0 =@
|| Date modified || Type I=l
No ftems match your search.

ssssss

o | >
-
Files of type: | PowerPoint Presentations - Cancel J)
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Example: Applications Delivered by XenApp 7.5 Platinum
PowerPoint Viewer, Adobe Reader, and Mozilla Firefox

8 o7

cbupocCitrx/StoreWeb o-cl@

Citrix Receiver
B8 Adobe Reader

(===
Fie Edt View Window Help

= Documents &3 F) [ B e 0 ] " Tools | Sign | Comment

v Export PDF

‘Adobe ExportPDF

Convert PDF files to Word or Excel
oniine.

Select POF File:

Open a Recent File

B My Computer.

L Microsoft Office PowerPoint Viewer
Looki: (5 Documerts - e @

Name = Date modified  Type

Notems match your search.

Google Search

more sbout
d our global Maker

¥ ® O

e e T Dounloads  Bookmarks

Flesoftpe: [PowerPom Presentaions )

Choose WhatIShare | x
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4,5.8 Configuring Advanced ICA Connection Settings

The table below provides a description of each setting item for ICA connections. Please refer to this table to
configure advanced settings and customize shortcuts on the desktop and Start menu for service access.

NOTE

(]

- Please note that available settings vary depending on the selected connection type.

Settings for the Connection Type of Web Logon
=)) NOTE

- For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 100.

- For descriptions of available settings for the connection type of XenApp, please refer
to “Settings for the Connection Type of XenApp” on page 103.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 106.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when Web Logon
is selected.

Four connection types are available:

Option Description

Provides application, desktop, and content
Web Logon access services through the interface of a
Web browser (Internet Explorer).

. XenDesktop Provides desktop delivery services.
Connection Type
XenApp Provides application delivery services.
. Provides full server access services for
Server Connection

administrators (XenApp servers only).

NOTE: When Web Logon is selected, your mt180W will use a Web browser for
service access. The Internet Explorer is always used no matter if you
have installed other browsers and which browser you have set as default.

For more details, please refer to section “4.5.7 Accessing Citrix Services”
on page 91.

Sever Address Type in the_ IP address / URL / FQDN of the server through which Citrix services
are accessible.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Web Settings
Item Description

Mode Setting

Click the drop-down menu to select the desired browser window mode. Two
options are available: Full Screen and Normal Mode.

Option Description
Full Screen The browser is opened in the Full Screen mode.
Normal Mode The browser is opened in the Normal mode.

NOTE: This setting item is available only when Web Logon is selected in the
Connection Type field. This type of connection allows you to access
services through the interface of the Web browser.

NOTE: The used Web browser for service access is always the Internet Explorer,
no matter which browser you set as the default.
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Settings for the Connection Type of XenDesktop

Wi

General Sub-tab

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 98.

- For descriptions of available settings for the connection type of XenApp, please refer
to “Settings for the Connection Type of XenApp” on page 103.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 106.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

This table only provides descriptions for available settings when XenDesktop is
selected.

Four connection types are available:

Option Description

Provides application, desktop, and content
Web Logon access services through the interface of a
Web browser (Internet Explorer).

XenDesktop Provides desktop delivery services.

XenApp Provides application delivery services.

Provides full server access services for

Server Connection administrators (XenApp servers only).

Sever Address

Type in the IP address / FQDN of the server through which XenDesktop
is accessible.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group

Type in the desktop group.

NOTE: You can use the Search icon ,'L-' in front of the field to discover available
desktop groups. For detailed instructions, please refer to “Connection
Type: XenDesktop” on page 85.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Window Settings
Item Description

Requested Color Quality

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: No preference, Better Speed (16-bit),
and Better Appearance (32-bit).

Option Description

No preference No preference for a specific color quality.

The 16-bit color quality is used for better

Better Speed (16-bit) display speed

The 32-bit color quality is used for better

Better Appearance (32-bit) desktop appearance.

Window Size

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Eight options are available: Default, Seamless, Full Screen,
640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, and 1600 x 1200.

NOTE: When the XenDesktop toolbar is enabled on the server side, you may not
be able to change the window size.

NOTE: For more information about how to disable the XenDesktop toolbar,
please visit Citrix websites at support.citrix.com or www.citrix.com for
online help.

NOTE: In case that you don’t want to disable the toolbar, you can use the
toolbar or your mouse to resize the launched window if needed.
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Device Mapping

Item

Description

Mapping Local Drive

Click the drop-down menu to enable/disable the mapping of the local drive(s) in a
Citrix ICA session. If Yes is selected, the locally attached drive(s) will become available in
launched Citrix ICA sessions.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

Mapping local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

Connection Settings

Item

Description

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Audio Quality

Click the drop-down menu to disable audio playback or choose the desired sound
quality in a Citrix ICA session.

Click the drop-down menu to disable audio playback or to configure the quality
setting for audio playback in a Citrix ICA session. Four options are available:
High - high definition audio, Medium - optimized for speech, Low - for
low-speed connections, and Off.

Option Description

Allows endpoint devices to play a sound
file at its native data transfer rate. This

High - high definition audio is recommended for connections where
bandwidth is plentiful and sound quality is
important.

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium - optimized for speech

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low - for low-speed connections  of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Disables audio playback in opened ICA

Off h
sessions.

Encryption

Click the drop-down menu to select the desired encryption method. Five options
are available: Basic, RC5 128 bit (login only), RC5 40 bit, RC5 56 bit,
RC5 128 bit.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local desktop, On the remote desktop,
In full screen desktops only.
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Settings for the Connection Type of XenApp

NOTE

Wi

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 98.

« For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 100.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 106.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when XenApp is
selected.

Four connection types are available:

Option Description
Provides application, desktop, and content
Web Logon access services through the interface of a
Connection Type Web browser (Internet Explorer).
XenDesktop Provides desktop delivery services.
XenApp Provides application delivery services.

Provides full server access services for

Server Connection administrators (XenApp servers only).

Sever Address Type in the IP address / FQDN of the server through which XenApp is accessible.
Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.

Type in the domain of the server.

Domain NOTE: Type in the full computer/server name if your XenApp server doesn’t
belong to any domain.

Type in the application name.

Application Name NOTE: You can use the Search icon ,'L-' in front of the field to discover available
applications. For detailed instructions, please refer to “Connection Type:
XenApp” on page 87.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Window Settings
Item Description

Requested Color Quality

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: No preference, Better Speed (16-bit),
and Better Appearance (32-bit).

Option Description

No preference No preference for a specific color quality.

The 16-bit color quality is used for better

Better Speed (16-bit) display speed

The 32-bit color quality is used for better

Better Appearance (32-bit) desktop appearance.

Window Size

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Eight options are available: Default, Seamless, Full Screen,
640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, and 1600 x 1200.

Device Mapping

Item

Description

Mapping Local Drive

Click the drop-down menu to enable/disable the mapping of the local drive(s) in a
Citrix ICA session. If Yes is selected, the locally attached drive(s) will become available in
launched Citrix ICA sessions through this connection.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.
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Mapping local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions through this connection.

Connection Settings

Item

Description

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Audio Quality

Click the drop-down menu to disable audio playback or choose the desired sound
quality in a Citrix ICA session.

Click the drop-down menu to disable audio playback or to configure the quality
setting for audio playback in a Citrix ICA session. Four options are available:
High - high definition audio, Medium - optimized for speech, Low - for
low-speed connections, and Off.

Option Description

Allows endpoint devices to play a sound
file at its native data transfer rate. This

High - high definition audio is recommended for connections where
bandwidth is plentiful and sound quality is
important.

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium - optimized for speech

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low - for low-speed connections of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Disables audio playback in opened ICA

Off )
sessions.

Encryption

Click the drop-down menu to select the desired encryption method. Five options
are available: Basic, RC5 128 bit (login only), RC5 40 bit, RC5 56 bit,
RC5 128 bit.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local desktop, On the remote desktop,
In full screen desktops only.
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Settings for the Connection Type of Server Connection

NOTE

Wi

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 98.

« For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 100.

- For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 103.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when
Server Connection is selected.

Four connection types are available:

Option Description
Provides application, desktop, and content
Web Logon access services through the interface of a
Connection Type Web browser (Internet Explorer).
XenDesktop Provides desktop delivery services.
XenApp Provides application delivery services.

Provides full server access services for

Server Connection administrators (XenApp servers only).

Type in the IP address / URL / FQDN of the XenApp server.

Sever Address NOTE: Server Connection only supports connections to XenApp servers.

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.

Type in the domain of the server.

Domain NOTE: Type in the full computer/server name if the server doesn’t belong to any
domain.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when Windows
Embedded starts.

If Yes is selected, every time when you log in to the system, the Citrix ICA
session will be opened automatically.

On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do nothing Returns to the Windows Embedded desktop.

Restart Application Opens a Citrix ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Application Sub-tab
Window Settings
Item Description

Requested Color Quality

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: No preference, Better Speed (16-bit),
and Better Appearance (32-bit).

Option Description

No preference No preference in a specific color quality.

The 16-bit color quality is used for better

Better Speed (16-bit) display speed

The 32-bit color quality is used for better

Better Appearance (32-bit) desktop appearance.

Window Size

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Eight options are available: Default, Seamless, Full Screen,
640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, and 1600 x 1200.

Device Mapping

Item

Description

Mapping Local Drive

Click the drop-down menu to enable/disable the mapping of the local drive(s) in a
Citrix ICA session. If Yes is selected, the locally attached drive(s) will become available in
launched Citrix ICA sessions through this connection.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.
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Mapping local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions through this connection.

Connection Settings

Item

Description

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Audio Quality

Click the drop-down menu to disable audio playback or choose the desired sound
quality in a Citrix ICA session.

Click the drop-down menu to disable audio playback or to configure the quality
setting for audio playback in a Citrix ICA session. Four options are available:
High - high definition audio, Medium - optimized for speech, Low - for
low-speed connections, and Off.

Option Description

Allows endpoint devices to play a sound
file at its native data transfer rate. This

High - high definition audio is recommended for connections where
bandwidth is plentiful and sound quality is
important.

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium - optimized for speech

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low - for low-speed connections of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Disables audio playback in opened ICA

Off )
sessions.

Encryption

Click the drop-down menu to select the desired encryption method. Five options
are available: Basic, RC5 128 bit (login only), RC5 40 bit, RC5 56 bit,
RC5 128 bit.

Apply Windows key
combinations

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local desktop, On the remote desktop,
In full screen desktops only.
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4,59 Configuring Basic VMware View Connection Settings

The VMware View setting enables you to configure View connection settings for VMware View or Horizon View
desktop services and create shortcuts on the desktop and Start menu for service access. You can access on-demand
desktop services for work simply through these shortcuts.

:%J NOTE

+ For more information on VMware desktop virtualization solutions, please visit
VMware website at www.vmware.com.

%J’ NOTE

+ You can also access VMware View or Horizon View services through the standard
desktop shortcut VMware Horizon View Client. For detailed instructions on how to
access services via the standard desktop shortcut, please refer to chapter 3 “Getting
Started” on page 15 or the Quick Start Guide for mt180W.

+ The following sections will guide you through the steps of creating your own service
access shortcuts on the desktop.

To quickly configure VMware View connection settings, please do the following:

1. On Atrust Client Setup, click Applications > VMware View.

2. The View Connection list appears in the Configuration area.

Atrust Applications | User Interface | Devices | System

” + Add = Delete
~ Session Name Server Address

* Remote Desktop
¢ Citrix ICA

~ VMware View

» Web Browser

Ly
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@‘/ NOTE

« If you haven't create any entry, the View Connection list will be empty.

3. Click Add on the top of the View Connection list to add a new entry of View connection.

Atrust Applications | User Interface | Devices | System
Navigat - =
General Application

' Remote Desktop

» Citrix ICA — Server Settings

¥ VMware View N -
Session Name: | |h

» Web Browser N
Cennection Server : | |h
Port: [ &
& Mluse secure connection (55L)
Certificate checking mode: ‘Wam before connecting to untrusted servers ;

— Login Settings
& Ovog in as current user
User Name: | |;
Password: | |;
Domain Name: [ &
Desktop Name: [ 4
Display Protacol: [Manual M
— Common Settings

Autostart When Startup: ‘ No EI;
On Application Exit: [De Nothing vle
save || cancel

4. Type in the desired session name, and then click Save to confirm.

@ NOTE

« This is the only required field for the creation of a service access shortcut on the
desktop. Other data can be provided during the period of service access. Depending
on your needs, you might choose to type in more other data.

5. The new entry is added to the View Connection list and the access shortcut is created automatically
on the desktop.
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4.5.10 Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Double click the created (customized) access shortcut on the desktop.

2. A window appears allowing you to add the name or IP address of the View Connection Server.

3. Double-click Add Server icon or click New Server in the top-left corner.

+ Mews Server | || e sener

—rt

Add Server

Add Server

4. A window appears prompting for the name or IP address of the View Connection Server. Enter the required
information, and then click Connect.

=
£

vmware Horizon

Enter the name of the Connection Server,

Connect

5. A window may appear with a certificate message about the remote server. Consult your IT administrator for
details and ensure the connection is secure first. To bypass, click Continue.

WMware Horizon Client cannot verify the identity of the server you
have contacted. Your credentials will not be secure. Contact your
administrator to ask if this server can be trusted.

e | [

6. A window may appear with a Welcome message. Click OK to continue.
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7. Provide your user name and password on the opened window, and then click Login.

=

vmware Haorizon

Server: [ﬁ Fems: [WVCS.VHY . poc

User name: | |

Password: |

Domain: |'u'H'.|'

8. A window appears with available desktops or applications for your credentials. Double-click to select the
desired desktop or application.

&Y @ wWesvHY.poc s 3 @~
| B p-
E
H

wi7u WS08R2 Adobe Reader XI Calculator LINE

) X

; I ot —
Mozilla Firefox Notepad Paint Skype Snipping Tool

Windows Media
Player

9. The desktop or application will be displayed on the screen.
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4.5.11 Configuring Advanced View Connection Settings

The table below provides a description of each setting item for View connections. Please refer to this table to
configure advanced settings and customize shortcuts on the desktop and Start menu for service access.

General Sub-tab

Server Settings

Item

Description

Session Name

Type in the name for VMware View or Horizon View sessions.

Connection Server

Type in the computer name or IP address of the View Connection Server.

NOTE: For more information on View Connection Sever, please visit VMware
website at www.vmware.com.

Port

Type in the port number used to communicate with the View Connection Server.
To use the default value, simply leave it blank.

Use secure connection (SSL)

Check/Uncheck to enable/disable secure connection.

Certificate checking mode

Click to select whether to verify the identity of the remote server and whether
to connect to an untrusted server. Three options are available: Do not verify
server identity certificates, Warn before connecting to untrusted
servers, and Never connect to untrusted servers.

Option Description
Do not verify server Do not verify the identity of the remote server
identity certificates and connect to it anyway.

Warn before connecting to  Warns and allows users to choose whether to
untrusted servers connect or not.

Never connect to

Disallows untrusted connections.
untrusted servers

Login Settings

Item

Description

Log in as current user

Check to log in to VMware View or Horizon View services with the current user
credentials. When checked, the User Name, Password, and Domain Name fields
will be grayed out.

User Name

Type in the user name for authentication.

Password

Type in the password for authentication.

Domain Name

Type in the domain name of the View Connection Sever.

Desktop Name

Type in the desktop name. Or, leave it blank for users to select one.

NOTE: If Manual is selected for the Display Protocol field below, this field will be
grayed out.
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Display Protocol

Click the drop-down menu to select the display protocol. Three options are
available: Manual, Microsoft RDP, and PCoIP.

Option

Description

Manual

Manually select the desired display protocol.

Microsoft RDP

Use Microsoft RDP as the display protocol.

PCoIP

Use VMware PColIP as the display protocol.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a VMware View or Horizon View session automatically or
not when Windows Embedded starts.

If Yes is selected, when you log in to the system, the VMware View or Horizon
View session will be opened automatically.

On Application Exit

Select what to do when a VMware View or Horizon View session is ended.
Four options are available: Do Nothing, Restart Application, Reboot, and

Shutdown.
Option Description
Do Nothing Returns to the Windows Embedded desktop.

Restart Application Opens a View or Horizon View session again.

Reboot

Restarts your thin client.

Shutdown

Turns off your thin client.

Application Sub-tab

Window Settings

Item Description
Click the drop-down menu to select the desired display size of a View desktop.
Five options are available: Full Screen, Multi Monitor, Large Window,
and Small Window.
Option Description
Display Full Screen Opens the selected View desktop in full screen.
Multi Monitor Opens the selected View desktop in multiple displays.

Large Window

Opens the selected View desktop in a large window.

Small Window

Opens the selected View desktop in a small window.
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4.5.12 Configuring Web Browser Settings

The Web Browser setting item allows you to configure browser session settings and create shortcuts on the
desktop or Start menu for browser sessions.

Configuring General Browser Session Settings
To configure general browser session settings, please do the following:

1. On Atrust Client Setup, click Applications > Web Browser > Global Setting.

Atrust Applications | User Interface | Devices | System
* Remote Desktop
» Citrix ICA — Basic Settings
N HwakYlew Home Page: [hitp:/fwwew atrusteorp.com/ B
~ Web Browser
Global Setting — Proxy Settings

& Ouse a proxy server for your
LAN

— Automatic Configuration

& Oautomatically detect settings
B [use automatic configuration

script

[Lsae |[ concer |

2. Refer to the table below to set up home page, proxy, and automatic configuration settings, and then click
Save to apply.

Basic Settings

Item Description

Home Page Type in the URL of a Web page for quick access via the Home button.

Proxy Settings

Item Description

Use a proxy server for your LAN | Check to use a proxy server in your local area network.

HTTP Proxy Server Type in the IP address of the proxy server.

HTTP Proxy Port Type in the communication port of the proxy server.

No Proxy For Type in the IP address(es) to bypass the proxy server.
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Automatic Configuration

Item Description

Automatically detect settings Check to automatically detect browser settings.

Use automatic configuration Check to allow automatic configuration and indicate the IP address where a
script configuration file is located.

Address Type in the IP address when Use automatic configuration script is selected.

Configuring Specific Browser Session Settings

To configure specific browser session settings and create shortcuts on the desktop and Start menu, please do
the following:

TIP
@
+ You can use this feature to create a desktop shortcut for a specific web page, for
example, your intranet home page.

1. On Atrust Client Setup, click Applications > Web Browser.

2. The Browser Session list appears in the Configuration area.

l\l:I'LISI: Applications | User Interface Devices System
» + Add = Delete
~ Sassion Name

» Remote Desktop
b Citrix ICA

» VMware View

~ Web Browser

Global Setting

o

5’/ NOTE

- If you haven't create any entry, the Browser Session list will be empty.
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3. Click Add on the top of the Browser Session list.

4. On General sub-tab, type in the desired session name, the URL of the initial web page, and select other
settings if needed (refer to the table below for descriptions).

Atrust Applications | User Interface | Devices | System
* Remote Desktop
» Citrix ICA — Basic Settings
’ i -
VMware View Session Name: Xl |L
~ Web Browser | | -
Initial P. :
Global Setting nial Fage =
— Common Settings
Autostart When Startup: [No Me
On Application Exit: ‘ Do Nothing &
save || cancel
Common Settings
Item Description

Autostart When Startup

Embedded starts.

session will be opened automatically.

Select whether to open a browser session automatically or not when Windows

If Yes is selected, every time when you log in to the system, the browser

On Application Exit

Select what to do when a browser session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing

Returns to the Windows Embedded desktop.

Restart Application

Opens a browser session again.

Reboot

Restarts your thin client.

Shutdown

Turns off your thin client.

5. Click Save to confirm. The access shortcut will be created automatically on the desktop.
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Appendices

This chapter provides instructions for the maintenance of your mt180W thin clients.

A.1 Resetting Your mt180W

How to reset your mt180W to the unmanaged state and its settings 121
under Atrust Client Setup to factory defaults

A.2 Restoring Your Operating System
How to restore the operating system for your mt180W 122
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A.1 Resetting Your mt180W

Reset Mode enables you to restore settings under Atrust Client Setup to the factory defaults. Additionally, it also
releases a managed mt180W from the management of Atrust Device Manager, a management console developed
by Atrust for remote and mass client management.

You can perform Reset Mode locally through Atrust Thin Client Menu.

NOTE

o)

+ You can also release a managed mt180W remotely from Atrust Device Manager.
For details, please refer to the User’s Manual for Atrust Device Manager.

To reset your mt180W, please do the following:

1. Restart your mt180W.
2. During the POST (Power-On Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

Atrust Thin Client Menu

Normal boot
Reset Mode

Firmware Update

Reboot
Shutdown

—)) NOTE
— - Five options are available on Atrust Thin Client Menu: Normal boot, Reset Mode,
Firmware Update, Reboot, and Shutdown. See the table below for the

description of each option:

wl

Menu Option Description

Normal boot Powers up your mt180W as the normal startup procedure.

Resets Atrust Client Setup settings and remote management

REsEE Hods status for your mt180W.

Firmware Update Updates firmware for your mt180W through the network.
Reboot Restarts your mt180W.

Shutdown Powers off your mt180W.

3. Use arrow keys to select Reset Mode, and then press Enter to continue.
4. A message appears prompting you for confirmation. Type y to confirm.

5. Upon completion, press Enter to restart.
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A.2 Restoring Your Operating System

The Recovery DVD for Atrust mt180W enables you to restore your operating system to the factory default state.

NOTE

[l

- Contact our technical support via fae@atrustcorp.com to get instructions on how
to get or make a Recovery DVD.

+ You can also restore your operating system in a similar way here with a Recovery
USB flash drive. Contract our technical support via fac@atrustcorp.com to get
instructions on how to make a Recovery USB flash drive with the help of Atrust
Recovery USB Disk Creator, a tool developed by Atrust.

To restore your operating system through the Recovery DVD, please do the following:

oA W

o

@ WARNING

+ Restoring your system will overwrite all of the data in your system. Ensure that
you've backed up important data before proceeding.

Attach a DVD drive to Atrust mt180W.

Insert the Recovery DVD.

Reboot your Atrust mt180W.

During the POST (Power-On Self-Test) period, press F7 to enter the Boot Device menu.

On the Boot Device menu, select to boot from the optical disc drive (the optical disc drive entry that
starts with UEFI), and then press Enter to continue.

The Atrust Recovery System screen appears.
Press Enter to continue.

A screen appears prompting you to select the source of recovery.
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Atrust Thin Client Recovery System

Valid device: /dev/sr0
CD-ROM mount successfully: device= /dev/sr0

Please choose one source:

CD/DVD

9. Select CD/DVD and then click Next to continue.
10. Select INSTALL or UPDATE, and then click Next to continue.

11. A screen appears prompting your to select the language of the user interface for your Atrust mt180W. Select
the desired language, and then press Next to continue.

%J’ NOTE

- The available Ul languages may vary with the firmware version of your mt180W.

12. The system recovery starts.

13. After completion, remove the Recovery DVD and then click Finish to restart your system.
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Processor

Intel® Celeron® N2807, Dual-core, 1.58 GHz

System Memory

2 GB DDR3 (Optional: 4 GB)

Flash Memory

8 GB mSATA (Optional: 16 /32 / 64 GB)

DiSPIa)I Type: 14" 16:9 Glare

Maximum Resolution: 1366 x 768
Keyboard / Touchpad Keyboard: 87 keys

Touchpad: 2-button Glide pad
Sound Built-in speakers

11.1V, 5900 mAh, 65 Wh

|/O interfaces Left side: Right side: Display and base:
1xDCIN  1xRJ-45 1xUSB2.0 1xSmartcardslot (Optional) 1xMicrophone port 1 x Built-in microphone
1xVGA 1xUSB3.0 1xUSB2.0 1x Headphone port 2 x Built-in speaker
Networking 10/100/1000 Mb Ethernet
Wi-Fi 802.11 a/b/g/n
AC Adapter INPUT: 100-240 V, ~2.5 A, 50-60 Hz
OUTPUT: 19V, 3.42 A, 65W
Battery Pack Rechargeable lithium-ion battery

Operating system

Windows Embedded 8 Standard

Supported Protocols

Microsoft RDP with RemoteFX / Citrix ICA with HDX / VMware PColP

Management Atrust Client Setup / Atrust Device Manager
Security Kensington security slot

Dimensions (W)339 x (D)239.4 x (H)25.4 mm
Weight 1.7 kg (approx.)

Environment

Operating Temperature: 0°C~35°C
Non-operating Temperature: -30°C~60°C
Operating Humidity (Rh): 10% ~ 90% (non-condensing)

Non-operating Humidity (Rh): 5%~ 95%
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